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1. Определение амплитудно-частотных характеристик ультразвукового 
волновода продольных колебаний 

Автор: Лавриненков А. Д. 

Организация: НТУУ «Киевский политехнический институт» 

E-mail: alavrinenkov@hotmail.com 

В рамках данной задачи производится нахождение резонансной частоты 

продольных колебаний ультразвукового ½ - волнового ступенчатого волновода, 

упругого смещения материала и распределение напряжений по сечению 

волновода при прохождении волны. На рисунке 1.1 показана геометрия детали и 

основные размеры волновода. Волновод состоит из концентратора колебаний 1, 

двух пьезоэлектрических элементов 2, частотопонижающей накладки 3, шпильки 

5 и гайки 4. 

 
Рисунок 1.1 – Ультразвуковой волновод продольных колебаний  

Граничные условия: 

1. Между всеми деталями волновода задается связь, моделирующая 

акустический контакт; 

2. К поверхностям А, Б, В и Г прикладывается электрический потенциал. 
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Проводится сравнение результатов моделирования с экспериментальными 

данными. 

1.1 Система координат модели и система единиц измерения 

Построение расчетной модели и обработка результатов производится в 

декартовой системе координат. Детали волновода рассматриваются как 

осесимметричные. При моделировании принята следующая система единиц 

измерений – SI. 

Таблица 1.1 – Система единиц измерения 

Длина Сила Масса Время Напряжение 
Электрическая 

емкость 
Температура Плотность 

𝑚 𝑁 𝑘𝑔 𝑠 V F ºC 𝑘𝑔\𝑚3 

1.2 Геометрическая модель 

Волновод состоит из ступенчатого концентратора, двух пьезокерамических 

колец, частотопонижающей накладки и болта.  

Создадим геометрическую модель ступенчатого концентратора. Для 

создания геометрической модели детали нажмите кнопку Create Part  в модуле 

Part  или дважды щёлкните на иконку  в дереве модели. 

В появившемся окне Create Part (Рисунок 1.2) присвойте детали имя 

Axisymmetric concentrator и примите следующие установки детали: Axisymmetric 

(осесимметричное), Deformable (деформируемое) и Shell (оболочка) в качестве 

базового свойства. В текстовом поле Approximate size наберите 0,3. Кликните 

Continue, чтобы закрыть диалоговое окно. В появившемся рабочем окне, с 

помощью инструмента  создаем контур концентратора по координатам 

контрольных точек (после задания координат каждой точки, подтверждаем свой 

выбор клавишей Enter или средней кнопкой мыши): (0.000, 0.0165), (0.000, 

0.0825), (0.0025, 0.0825), (0.0025, 0.0965) , (0.0115, 0.0965) , (0.0115, 0.038) , 

(0.0235, 0.038) , (0.0235, 0.0365) , (0.0195, 0.0365) , (0.0195, 0.000) , (0.0052, 0.000) , 
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(0.0052, 0.0165) , (0.000, 0.0165). В случае ошибки можно произвести отмену 

действия при помощи кнопки Cancel. 

  
Рисунок 1.2 – Построение эскиза детали Axisymmetric concentrator 

Контур концентратора должен быть замкнутым и ось концентратора должна 

совпадать с осью симметрии (в рабочей зоне – зеленая штрихпунктирная линия). 

С помощью инструмента  создайте радиус скругления. Задайте радиус 

скругления Fillet radius – 0,008 м, подтвердите значение радиуса клавишей Enter 

и курсором выделите прямолинейные отрезки, между которыми необходимо 

произвести скругление (Рисунок 1.2). Выходим из режима Эскиз, нажав на кнопку 

Done. 

Создаем вторую деталь с аналогичными параметрами. Присваиваем ей имя 

Piezoceramics-1. С помощью инструмента  создаем эскиз детали по точкам с 

координатами: (0.0065, 0.000), (0.0065, 0.0045), (0.0195, 0.0045), (0.0195, 0.000), 

(0.0065, 0.000) (Рисунок 1.3). Выходим из режима Эскиз,  нажав кнопку Done. 
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Рисунок 1.3 - Эскиз детали Piezoceramics 

В дереве модели нажимаем на созданную деталь Piezoceramics-1 правой 

кнопкой мыши и из появившегося списка выбираем Copy. В появившемся окне 

(Рисунок 1.4), переименовываем деталь в Piezoceramics-2. Подтверждаем 

действие нажатием кнопки ОK. Третья деталь создана. 

 
Рисунок 1.4. Создание детали Piezoceramics-2 

Создаем четвертую деталь, присваиваем ей имя Plate. С помощью 

инструмента  создаем эскиз детали по точкам с координатами: (0.0061, 0.000), 

(0.0061, 0.012), (0.0195, 0.012), (0.0195, 0.002), (0.0175, 0.000), (0.0061, 0.000) 

(Рисунок 1.5). Выходим из режима Эскиз,  нажав кнопку Done. 
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Рисунок 1.5. Эскиз детали Plate 

Создаем пятую деталь, присваиваем ей имя Bolt. С помощью инструмента  

создаем эскиз детали по точкам с координатами: (0.000, 0.000), (0.010, 0.000), 

(0.010, 0.011), (0.0052, 0.011), (0.0052, 0.044), (0.000, 0.044), (0.000, 0.000) 

(Рисунок 1.6). Выходим из режима Эскиз,  нажав на кнопку Done. 

 
Рисунок 1.6. Эскиз детали Bolt 

1.3 Модель материала 
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Конечно-элементное моделирование ультразвуковых устройств, включает, 

как частотный анализ собственных частот, так и отклик на гармоническое 

возбуждение. Для частотного анализа необходимо задать физико-механические 

свойства: плотность и упругие свойства материала. Для анализа отклика на 

гармоническое возбуждение: диэлектрические и пьезоэлектрические свойства. 

В Дереве Модели дважды кликните по контейнеру Materials , 

чтобы создать новый материал. В появившемся окне Edit Material зададим имя 

материала – Steel-30XGSA. Плотность металла задаётся в окне General=>Density – 

7850 кг/м3. В меню редактора выберем Mechanical=>Elasticity=>Elastic и введем 

значение Модуля Юнга Young’s Modulus – 2,15 ∗ 1011 Па, а также коэффициент 

Пуассона Poisson’s Ratio – 0.3. (Рисунок 1.7). 

  

Рисунок 1.7 – Задание свойств материала Steel-30XGSA 

Создадите материал с именем Steel-40Х. Плотность - 7820 кг/м3; модуль 

Юнга – 2,14 ∗ 1011 Па; коэффициент Пуассона – 0.3. (Рисунок 1.7). 

Создадите материал с именем Steel-40Х13. Плотность - 7650 кг/м3; модуля 

Юнга – 2,18 ∗ 1011 Па; коэффициент Пуассона – 0.3. 
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Теперь перейдем к созданию материала пьезокерамический колец. Создайте 

материал с именем PZT-5. Задайте значение плотности - 7850 кг/м3. 

Механические характеристики пьезокерамики будут описываться тремя модулями 

Юнга, тремя коэффициентами Пуассона и тремя модулями сдвига. В меню 

редактора выберем Mechanical=>Elasticity=>Elastic, тип type=>engineering 

constants. В таблицу вводим модули Юнга [Па]: 𝐸1 = 70,92 ∗ 109, 𝐸2 = 55,86 ∗

109, 𝐸3 = 70,92 ∗ 109; коэффициенты Пуассона:  

𝜈12 = 0,512, 𝜈13 = 0,289,  𝜈23 = 0,512; модули сдвига [Па]: 𝐺12 = 21,7 ∗ 109, 

𝐺13 = 23,4 ∗ 109, 𝐺23 = 21,7 ∗ 109 (Рисунок 1.8). 

 
Рисунок 1.8. - Задание упругих свойств пьезокерамики 

Создадим диэлектрические свойства пьезокерамики. В меню редактора 

выберем Electrical/Magnetic=>Dielectric(Electrical Permittivity), тип 

Type=>Orthotropic. В таблицу вводим значения диэлектрической проницаемости 

[Ф/м]: 𝐷11 = 1.505 ∗ 10−8, 𝐷22 = 1.301 ∗ 10−8, 𝐷33 = 1.505 ∗ 10−8 (Рисунок 1.9). 
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Рисунок 1.9. - Задание диэлектрических свойств пьезокерамики 

Для задания пьезоэлектрических свойств пьезокерамики, в меню редактора 

выберем Electrical/Magnetic=>Piezoelectric, тип Type=>Strain. В таблицу вводим 

коэффициенты деформации (м/В) (Рисунок 1.10) 

 
Рисунок 1.10. - Задание пьезоэлектрических свойств пьезокерамики 
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Теперь перейдём к определению сечений. Откройте диалоговой окно Create 

Section (вызов возможен либо из Дерева модели, либо через иконку ). В 

диалоговом окне Create Section присвойте сечению имя Axisymmetric 

concentrator. Выберите Category=>Solid, Type=>Homogoneous и кликните на 

кнопку Continue. В появившемся окне редактора сечений Edit Section, в качестве 

материала, необходимо указать материал Steel-30XGSA. Подтвердите выбор 

нажатием кнопки ОК (Рисунок 1.11). 

 

 

Рисунок 2.11 – Создание сечения Axisymmetric concentrator 

Создайте сечения для каждой детали волновода. Для пьезокерамических 

колец сечение с именем Piezoceramics, c присвоением материала – PZT-5. Для 

частотопонижающей накладки – сечение с именем Plate, с присвоением 

материала – Steel-40X13. Для болта – сечение с именем Bolt, c присвоением 

материала - Steel-40X. 

Следующим шагом будет присвоение построенных сечений ранее созданным 

деталям. Для этого используем иконку  Assign Section в текущей панели 

инструментов (либо дважды нажимаем по элементу  в дереве модели, либо 

используем команды меню: Assign => Section). Выделите концентратор, он будет 

подсвечен красным цветом. Нажмите Done. В появившемся окне (Рисунок 1.12), 

выберите созданное сечение и подтвердите выбор нажатием кнопки ОК. 

Присвойте, таким способом, построенные сечения всем деталям. 
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Рисунок 1.12 – Создание сечения Axisymmetric concentrator 

При моделировании пьезоэлектрических материалов необходимо указывать 

направления поляризации пьезоэлектрических материалов. Для этого в дереве 

модели откроем модуль Part =>Piezoceramics-1, двойной клик на Orientations, в 

рабочем окне выбираем модель пьезокерамического кольца, деталь становится 

подсвеченной красным цветом, нажимаем на Done. На запрос Select a CSYS 

нажимаем Use default Orientation or other method. В появившемся окне Edit 

Material Orientations , из списка Definition, выбираем систему координат Global, 

из списка Stacking direction, отмечаем Element isoparametric direction 2. 

Подтверждаем выбор нажатием на кнопку ОК (Рисунок 1.13). 

 

 

Рисунок 1.13 - Определение направления поляризации 

пьезокерамических колец 
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1.4 Предварительная сборка 

Перейдём к модулю ASSEMBLY. Для создания сборочной единицы 

необходимо нажать на иконку Create Part Instance  (либо в дереве модели 

дважды кликаем по элементу  , либо воспользоваться  командами: меню 

Instance => Create). Появится окно со списком созданных деталей Parts. 

Выбираем все детали из списка. В разделе Instance Type укажите Independent и 

подтвердите выбор, нажав ОК. В рабочей зоне появились все ранее созданные 

детали, некоторые из них пересекаются с другими. Для удобства задания условий 

контакта и граничных условий все детали необходимо разнести друг от друга на 

удобное расстояние. 

  
Рисунок 1.14. Предвариетльная сборка деталей модели волновода 

 С помощью инструмента  выделяем первый пьезокерамический диск 

(контур второго совпадает с контуром первого), жмем клавишу Enter или кнопку 

Done. В командной строчке появился запрос на указание первой точки для 

перемещения, жмем клавишу Enter, присваивая координаты первой точки (0.0, 
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0.0). В командной строчке, с запросом на координаты второй точки, пишем (0.0, -

0.01). Подтверждаем координаты клавишей Enter. Пьезокерамический диск 

переместился на заданное расстояние. Возможно возвращение к предыдущему 

действию . Окончательное перемещение детали подтверждаем клавишей Enter. 

После перемещения всех деталей сборка должна выглядеть следующим образом - 

Рисунок 1.14.  

1.5 Определение процедуры анализа 

Численное моделирование будет состоять из двух этапов: 

1) Частотный анализ модели (Frequency): 

Данный расчет позволяет определять собственные частоты, моды и формы 

колебаний конечно-элементной модели. В качестве решателя собственных частот 

был выбран решатель Lanczos. 

2) Совмещенный пьезоэлектрический анализ и отклик системы на 

гармоническое возбуждений (Steady-state dynamics, Direct): 

Данный анализ моделирует отклик волновой системы на непрерывное 

гармоническое возбуждение. Источником возбуждения является 

пьезоэлектрический эффект, в пьезокерамических элементах, возникающий при 

наложении электрического поля (приложение к пьезоэлементам электрического 

потенциала), результатом чего является деформация пьезоэлектрических 

элементов.  

В Дереве Модели дважды кликните по контейнеру Step. В окне Create Step 

задайте имя нового шага анализа – Frequency. Из списка Procedure type выбираем 

Linear perturbation. Из появившегося списка выбираем Frequency, жмем ОК. В 

окне Edit Step, в качестве типа решателя Eigensolver, выбираем Lanczos. Ставим 

галочку на Minimum frequency of interest (cycles/time) и вводим значение 21000, в 

Maximum frequency of interest (cycles/time) вводим значение 22000, остальные 

настройки решателя оставляем без изменений и нажмите ОK (Рисунок 1.15). 
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Рисунок 1.15 – Определение процедуры анализа шага - Frequency 

Перейдем к созданию второго шага расчета – расчета отклика системы на 

гармоническое возбуждение – пьезоэлектрический эффект. В Дереве Модели 

дважды кликните по контейнеру Step . В окне Create Step задайте имя 

нового шага анализа –  Amplitude response. Из списка Procedure type выбираем 

Linear perturbation. Из появившегося списка, выбираем Steady-state dynamics, 

Direct. В окне Edit Step отмечаем Compute real response only. В строке Scale 

отмечаем Linear, также ставим галочку на пункте Use eigenfrequencies to 

subdivide each frequency range (Использовать собственные частоты для 

разделения амплитудного диапазона). В таблице в графе Lower Frequency вводим 

минимальную интересующую нас частоту 21000 и в графе Upper Frequency - 

22000, в графе Number of Points (число частот, включая собственные частоты, на 

которое будет разбит частотный диапазон в 1000 Гц) вводим 10, в графе Bias 

(смещение) вводим 1 (частотный диапазон в 1000Гц будет равномерно разбит на 

10 точек). Во вкладке Other диалогового окна Edit Step, в качестве Equation Solver 

(типа решателя), выбираем Use solver default. Подтверждаем выбор параметров 

нажатием на кнопку OK (Рисунок 1.16).  
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Рисунок 1.16 – Определение процедуры анализа шага –  

Steady-state dynamics, Direct 

Сформируем запрос на вывод полевых переменных. Раскрываем дерево 

 и нажимаем на F-Output-1. Помимо переменной, по умолчанию U 

(Translations and rotations), запросим вывод деформаций и напряжений (Strains: 

E, Total strain components; Stress: S, Stress components and invariants (Рисунок 

1.17)). 

 
Рисунок 1.17 – Выбор параметров вывода результата расчета 



 

Современные технологии - в промышленность 

Программное обеспечение 
Инженерный консалтинг 

Вычислительная техника 
Измерительное оборудование 

 
 

18 
 

Произведем описание процедуры вывода АЧХ одной из точек волновода. 

Вернемся в модуль Assembly, дважды нажимаем на . В появившемся окне 

Create Set, присваиваем имя Point, в Type помечаем Geometry и нажимаем на 

кнопку Continue. В рабочем окне, на запрос Select the geometry for the set, 

выделяем точку на торце, как показано на Рисунке 1.18, точка стала 

подсвечиваться красным цветом, жмем на кнопку Done. 

  
Рисунок 1.18 – Выбор точки для 

построения АЧХ 

Рисунок 1.19 – Вывод перемещений 

контрольной точки 

Возвращаемся в History Output Request, дважды нажимаем на H-Output-1. В 

поле Domain, из выпадающего списка, выбираем Set, в соседнем поле, из списка 

Sets, выбираем Point. Выберите переменную U, Translations and rotations в блоке 

Displacement/Velocity/Acceleration (Рисунок 1.19). 

1.6 Контактные взаимодействия 

Между всеми деталями ультразвукового волновода существует акустический 

контакт, который обеспечивается прохождение ультразвуковой волны по всей 

длине волновода. Для моделирования акустического контакта в дереве модели 



 

Современные технологии - в промышленность 

Программное обеспечение 
Инженерный консалтинг 

Вычислительная техника 
Измерительное оборудование 

 
 

19 
 

дважды нажимаем на Constraints (Связи) . В появившемся окне Create 

constraint присвоим имя Concentrator-Piezo1, из предлагаемого списка связей 

выбираем тип Tie (Рисунок 1.20). Для создания «жесткой» связи необходимо 

выбрать главную поверхность Master и подчиненную Slave. При выборе следует 

руководствоваться следующим правилом: поверхность Master должна 

принадлежать детали с большей плотностью, поверхность Slave к детали с 

меньшей плотностью. Тип  Master поверхности – Surface. В рабочем окне 

выбираем поверхность детали Concentrator, прилегающую к детали Piezoceramics-

1. Поверхность стала подсвечиваться красным цветом, подтверждаем выбор 

нажатием на Done. Перейдем к выбору Slave поверхности (тип - Surface). В 

рабочем окне выбираем поверхность детали Piezoceramics-1, прилегающую к 

детали Concentrator. Выбранная поверхность стала подсвечиваться розовым 

цветом, подтверждаем выбор нажатием на Done. Применяем следующие 

настройки «жесткого» контакта – Рисунок 1.20. 

  
Рисунок 1.20 – Создание неразрывной связи между концентратором и 

пьезокерамическим кольцом 
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Создаем контактные связи Constarins для всех деталей волновода кроме уже 

созданной: 2) Piezo1-Piezo2; 3) Piezo2-Plate; 4) Plate-Bolt; 5) Bolt-Concentrator 

(резьбовая часть) (Рисунок 1.21). 

 
Рисунок 1.21 – Поверхности Tie Constarins 

1.7 Нагрузки и граничные условия 

Для задания электрического потенциала в дереве модели дважды нажимаем 

на , присваиваем имя граничному условию ElPotention Frequency, в 

Category выбираем Electrical/Magnetic, подтверждаем действие нажатием на 

кнопку Continue. В рабочем окне курсором выделяем горизонтальные 

поверхности пьезокерамических колец, нажимаем на кнопку Done, в 

появившемся окне подтверждаем операцию нажатием на ОК (Рисунок 1.22). 
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Рисунок 1.22 – Задание граничных условий на шаге Frequency 

Создаем граничное условие с именем Piezo11-Piezo22 в поле Step, выбираем 

Amplitude resoponse, жмем Continue. В рабочем окне выделяем верхнюю 

поверхность  детали Piezoceramics-1 и нижнюю поверхность детали 

Piezoceramics-2 (становятся подсвеченными красным цветом), жмем Done. В окне 

Edit Boundary Conditions, в графе Magnitude вводим 0 B (Рисунок 2.24, а). 

Создаем граничное условие с именем Piezo12-Piezo21 на шаге Amplitude 

resoponse, жмем Continue. В рабочем окне выделяем нижнюю поверхность детали 

Piezoceramics-1 и верхнюю поверхность детали Piezoceramics-2 (становятся 

подсвеченными красным цветом), жмем Done. В окне Edit Boundary Conditions, в 

графе Magnitude вводим 200 В (Рисунок 1.23, б). Теперь к каждому 

пьезоэлектрическому кольце приложен электрический потенциал 200 В. 
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а) б) 

Рисунок 1.23 – Задание граничных условий на шаге Amplitude response 

1.8 Окончательная сборка 

Для окончательной сборки вернёмся в модуль Assembly и с помощью 

инструмента  произведём сборку. Сборку деталей будем осуществлять 

относительно неподвижной модели Concentrator. Нажимаем на иконку , в 

рабочем окне, на запрос Select the instances to translate, выберем деталь 

Piezoceramics-1, жмем Enter или нажимаем на Done. На запрос Select a start point 

for…, курсором выбираем верхнюю правую точку детали (она подсветится 

розовым цветом), на запрос Select an end point…, выбираем крайнюю правую 

нижнюю точку детали Concentrator (Рисунок 1.24). Поверхность 

пьезокерамического диска соединилась с поверхностью концентратора, 

подтверждаем действие клавишей Enter или нажимаем на кнопку OK. 

Проделываем туже операцию со всеми деталями, вплоть до детали Bolt.  
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Рисунок 1.24 – Окончательная сборка деталей волновода 

Произведём позиционирование детали Bolt. Для этого в главном меню 

выбираем Tools=>Query, в окне General queries выбираем Point, и, с помощью 

курсора, выбираем две точки для определения их координат (Рисунок 1.25).  

  

Рисунок 1.25 – Определенение расстояния между двумя точками 

В командной строке появится текущие координаты точек (Рисунок 1.26).  

 
Рисунок 1.26 – Вывод информации о расстоянии между двумя точками 
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Используя инструмент , выбираем деталь Bolt, на запрос Select a start point 

for вводим координаты второй точки (0,052; -0,056), на запрос Select an end 

point… вводим следующие координаты (0,052; -0,034). 

Окончательная сборка волновода представлена на рисунке 1.26. 

 
Рисунок 1.26 – Волновод в сборе 

1.9 Конечно-элементная модель 

Переходим к модулю Mesh , в поле Object выбираем 

Part из списка деталей – Axisymmetric concentrator 

. В рабочей зоне появился 

концентратор. На панели инструментов модуля Mesh жмем на иконку  (Seed 

Part), в появившемся окне Global Seeds вводим значение Approximate global size – 

0.00135, жмем OK. На панели инструментов жмем на иконку  (Assign Mesh 

Controls), в появившемся окне Mesh Controls выбираем форму конечного 

элемента Quad, Technique-Free, Algorithm – Medial axis, ставим галочку на 

Minimize the mesh transition. На панели инструментов модуля Mesh жмем на 

иконку  (Mesh Part). 
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Рисунок 1.27 – Процедура создание сетки конечных элементов детали 

Axisymmetric concentrator 

Построение сетки конечных элементов деталей Bolt и Plate аналогична 

процедуре, описанной выше, за исключением того, что в окне Global Seeds 

вводим значение Approximate global size – 0.0014. В окне Element Type  (Mesh 

=> Element Type) по умолчанию из списка Family выбран элемент CAX4R (если 

нет, укажите параметры как на Рисунке 1.28). 

  

Рисунок 1.28 – Выбор типа конечных 

элементов металлических деталей 

волновода 

Рисунок 1.29 – Выбор типа конечных 

элементов пьезоэлектричких колец 
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Для расчета пьезоэлектрического эффекта необходим определенный тип 

конечных элементов. При построении сетки конечных элементов деталей 

Piezoceramics-1 и Piezoceramics-2, в окне Global Seeds вводим значение 

Approximate global size – 0.0014. В окне Element Type  (Mesh => Element 

Type), из списка Family,  выбираем Piezoelectric, выбран элемент CAX4E (Рисунок 

1.29). В итоге, сетка конечных элементов деталей Piezoelectric-1 и 2, Bolt и Plate, 

должна иметь вид, как на Рисунке 1.30, по отдельности и в сборе. 

 

  

 

Рисунок 1.30 – Сетка конечных элементов деталей волновода 

1.10 Запуск на расчет 

Перейдите в модуль JOB. С помощью иконки  Create Job  (либо команд 

меню  Job => Create или дважды щёлкнув по элементу в дереве модели) создайте 

задание на расчёт. В появившемся  окне Create Job,  присвойте заданию имя 

Axisymmetric concentrator (Рисунок 1.31). 
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Рисунок 1.31 – Определение задания на расчет 

Для продолжения нажмите кнопку Continue. Задание на расчёт 

сформировано. Чтоб запустить расчёт, вызовите  Job Manager (Рисунок 1.32) 

(либо раскройте элемент дерева модели, щёлкните правой кнопкой по 

заданию Axisymmetric concentrator и выберите Submit, либо командами меню Job 

=> Manager). 

В появившемся окне Job Manager нажмите Submit. Надпись Running 

говорит о том, что расчёт запустился. 

  
Рисунок 1.32 – Постановка задачи на расчёт 

1.11 Анализ полученных результатов 

После того, как расчёт успешно закончился, в окне Job Manager, в графе 

Status надпись с Running, поменяется на Completed. Для просмотра результатов 
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расчёта, в окне Job Manager, нажмите Results или в списке Module выбираем 

Visualization. В рабочей зоне экрана появится недеформированная конечно-

элементная модель волновода (Рисунок 1.33). 

  

Рисунок 1.33 – Визуализация результатов расчета 

Результаты расчета, которые нас интересуют, это: резонансная частота 

продольных колебаний, распределение интенсивности напряжений в волноводе, 

картина упругого смещения материала волновода и амплитуда колебания торца 

волновода в точке Point. 

Для просмотра данных результатов на различных шагах работаем с панелью 

 в верхней правой части экрана. Щёлкните на , появится 

рабочее окно Frame Selector (Рисунок 1.34).  

  
а б 

Рисунок 1.34 – Вывод шага расчета 

Перемещая ползунок на экране выводятся результаты расчёта на различных 

шагах. Переместите ползунок на позицию 10, в рабочей зоне появится упруго 

деформированный волновод на резонансной частоте 21466 Гц, при 
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гармоническом возбуждении от пьезоэлектрического эффекта. Для вывода 

картины распределения напряжений перемещений и т.д., можно воспользоваться 

вкладкой главной панели Result-Field Output, и, после появившегося окна Field 

Output (Рисунок 1.35), из ранее определённого нами списка параметров, выбираем 

S (Stress components at integration points), при этом результаты выводятся в 

рабочей зоне экрана.  

  
Рисунок 1.35 – Интенсивность напряжений в волноводе 

Наибольшие растягивающие напряжения возникают вблизи зоны перехода со 

ступени концентратора большего диаметра на ступень меньшего диаметра. 

Интенсивность напряжений в этом месте достигает 173 МПа. 

В окне Field Output в Output variable выберем U, spatial displacement at 

nodes, в окне Components выбираем U2. В рабочей зоне экрана будет отображена 

картина упругого смещения материала волновода в направлении оси Y (Рисунок 

1.36). 
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Рисунок 1.36 – Интенсивность напряжений в волноводе 

Максимальна амплитуда торца составида 28 мкм, что в пределах амплитуд 

для тупенчатых концентраторов из стали 30ХГСА. 

Для вывода АЧХ точки Point на торце концентратора, кликаем на вкладке 

главной панели Result => History Output, и, в появившемся окне History Output 

(Рисунок 1.37) из списка выбираем Spatial displacement: U2 P1, жмём на кнопку 

Plot. В рабочей зоне появится график (Рисунок 1.38). 

 



 

Современные технологии - в промышленность 

Программное обеспечение 
Инженерный консалтинг 

Вычислительная техника 
Измерительное оборудование 

 
 

31 
 

Рисунок 1.37 – Вывод результатов расчёта в виде графиков 

 

 
Рисунок 1.38 – Частотно-амплитудная зависимость точки Point на торце 

волновода 

Полученное значение резонансной частоты волновода (21 466 Гц) хорошо 

коррелирует с экспериментальными данными – 21 000 Гц. 
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2. Моделирование крыла солнечной батареи спутника серии «ЭКРАН» 

Автор: Якимов И. Д. 

Организация: МФТИ (ГУ) 

E-mail: zoch@mail.ru 

В рамках данной задачи проводится построение имитационной модели по 

нахождению упругих тонов собственных колебаний крыла солнечной батареи 

спутника серии «Экран». На рисунке 2.1 представлены геометрические параметры 

крыла солнечной батареи.  
 

2045 

430 1300 

1635 

2600 

2905 

997 997 

159 

987 

333 

1605 

1688 

  

Рисунок 2.1 – Геометрические 

параметры модели 

Рисунок 2.2 – Свойства 

конструктивных элементов 

Граничные условия: 

1. Нижняя точка центральной штанги жёстко закреплена; 

2. Нижние точки каркаса панели, ближайшие к центральной штанге, жёстко 

привязаны к стержням виброметра, который возбуждает колебания только 

перпендикулярно общей плоскости конструкции. 

На рисунке 2.2 представлены необходимые свойства конструктивных 

элементов крыла солнечной батареи, разделённые цветовой градацией (d – 

диаметр, t – толщина): 
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1) Труба, d=4,9 см, t=0,3 см, сталь; 

2) Труба, d=4,9 см, t=0,2 см, алюминий; 

3) Труба, d=1,8 см, t=0,1 см, алюминий; 

4) Труба, d=3,8 см, t=0,2 см, алюминий; 

5) Балка «Z»-сечения, боковая сторона 0,9 см, продольная 2,9 см, t=0.1 см, 

алюминий; 

6) балка «Z»-сечения, боковая сторона 1,1 см, продольная 4,9 см, t=0.1 см,  

алюминий. 

Таблица 2.1 – Параметры материала 

Материал Плотность Модуль Юнга  Коэффициент 
Пуассона 

Алюминий 2700 kg/m3 70 GPa 0,3 

Сталь 7700 kg/m3 210 GPa 0,3 

1.1 Система координат модели и система единиц измерения 

Построение расчётной модели и обработка результатов производится в 

декартовой системе координат, принята следующая система измерений – SI. 

Таблица 2.2 – Система единиц измерения 

Длина Сила Масса Время Температура Плотность 

𝑚 𝑁 𝑘𝑔 𝑠 ºC 𝑘𝑔/𝑚3 

1.2  Геометрическая модель 

Создаём деталь в модуле Part. В окне Create Part принимаем следующие 

установки: 3D (трёхмерное), Deformable (деформируемое), и Wire – Planar, в 

качестве базового свойства (Рисунок 2.3). В появившемся рабочем поле, 

воспользовавшись инструментом , создаём эскиз солнечной батареи согласно 

размерам представленным на рисунке 2.1 (обозначаем точки в местах шарниров 

на центральной штанге для того чтобы в них расположить сосредоточенные 

массы). 
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Рисунок 2.3 – Эскиз солнечной батареи 

1.3  Модель материала 

В нашей модели нам необходимы только два материала – сталь и алюминий. 

В модуле Property выбираем Create Material, задаём свойства соответствующие 

таблице 2.1. Выбираем для этого в окне Edit Material пункты General – Density и 

Mechanical – Elasticity – Elastic. 

При помощи Create Section, мы создаём сечения балок, согласно рисунку 2.2. 

Выбираем тип сечения трубы – Pipe, а «Z»-сечение создаём с помощью Arbitrary, 

указав параметры, представленные на рисунке 2.4. 

При указании Assign: Beam Section Orientation, нужно внимательно 

проследить, чтобы продольная сторона сечения балок (по высоте сечения) шла 

вдоль оси z, как показано на рисунке 2.5. То, что нулевая точка сечения в данном 

случае не совпадает с центром тяжести сечения, мало влияет на результат.  
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Рисунок 2.4 – Указание геометрических размеров «Z»-сечений 

 
Рисунок 2.5 – Указание ориентации сечения балок 

1.4  Сборка 

Перейдём в модуль ASSEMBLY. Для создания сборочной единицы 

необходимо нажать на иконку Create Part Instance  (либо в дереве модели 

дважды кликнуть по элементу  , либо воспользоваться  командами: меню 

Instance => Create). Появится окно со списком созданных деталей Parts. В нашем 

случае деталь одна, выберем её и подтвердим выбор, нажав ОК. 

1.5  Определение процедуры анализа 

В модуле Step заходим в Create Step. Выбирая в Procedure type тип Linear 

perturbation, задаём частотный анализ Frequency. Остальные настройки можно 

оставить по умолчанию. Задаем величину Maximum frequency of interest – 20. 
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Рисунок 2.6 – Определение процедуры анализа 

1.6  Контактные взаимодействия 

В нашем случае нам необходимо задать в узлах точечные массы, 

соответствующие креплениям и шарнирам (так как последние жёстко 

закреплены). В модуле Interactions из верхнего меню выбираем Special – Inertia – 

Manager и создаём 5 точечных масс в точках, показанных на рисунке 2.7. При 

задании масс обратите внимание на рисунок 2.8. 

  
Рисунок 2.7 – Распределение точечных 

масс 
Рисунок 2.8 – Задание точечных 

масс 
На рисунке 2.7 с помощью цветовой градации обозначены следующие 

точечные массы: 

1) Большие жёстко закреплённые шарниры, разворачивающие центральную 

штангу панели - 0.5 kg; 
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2) Стягивающие крепления - 0.1 kg; 

3) Жёстко закреплённые шарниры, разворачивающие панель - 0.31 kg; 

4) Жёстко закреплённые шарниры, разворачивающие панель - 0.4 kg; 

5) Малые стягивающие крепления - 0.07 kg. 

1.7  Нагрузки и граничные условия 

Для задания граничного условия, на нижней грани пластины, перейдём в 

модуль Load. В окне Create Boundary Condition выберем механический тип 

граничных условий, нажмём OK, и, выбрав самую нижнюю точку центральной 

штанги, зададим ей условие ENCASTRE (жёсткое закрепление по всем 

направлениям). Создадим второе механическое граничное условие, но на этот раз 

из пункта Displacement/Rotation, и, выбрав нижние точки каркаса панели, 

ближайшие к центральной штанге, присвоим им условие, ограничивающее их 

степень свободы по перемещениям U1, U2 и вращению UR3, как показано на 

рисунке 2.9. Второе граничное условие описывает виброметры, которые 

закреплены в данных точках. 

 
Рисунок 2.9 – Задание граничных условий 
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1.8  Конечно-элементная модель 

В модуле Mesh, в окне Global Seeds, вводим приблизительный размер 

элемента 0.08, чтобы размер самых маленьких элементов (между панелями и 

штангой) был приблизительно равен остальным элементам. Производим 

разбиение (Mesh Part instance).  

1.9  Запуск на расчет 

В модуле Job создаём новый расчёт, оставляя все параметры по умолчанию. 

 1.10 Анализ полученных результатов 

В таблице 2.3 приведено сравнение результатов расчёта собственных частот 

(в Гц) с экспериментальными данными. 

Таблица 2.3 – Сравнение результатов моделирования с экспериментальными 
данными 

Номер тона Расчёт Эксперимент Погрешность, % 

1 2,31 2,31 0,00 

2 3,74 3,75 0,27 

3 6,66 6,5 2,46 

4 7,69 7,88 2,41 

Ниже, на рисунках 2.10, 2.11, 2.12 и 2.13 представлены собственные формы 

(слева – экспериментальные, полученные с помощью лазерного сканирующего 

виброметра PSV-400-3D, справа  – расчетные). 



 

Современные технологии - в промышленность 

Программное обеспечение 
Инженерный консалтинг 

Вычислительная техника 
Измерительное оборудование 

 
 

39 
 

  
Рисунок 2.10 – 1 тон, слева эксперимент, f=2,31 Гц;  

справа расчёт, f=2,31 Гц 
 

  
Рисунок 2.11 – 2 тон, слева эксперимент, f=3,75 Гц;  

справа расчёт, f=3,74 Гц 
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Рисунок 2.12 – 3 тон, слева эксперимент, f=6,5 Гц;  

справа расчёт, f=6,66 Гц 

 
 

Рисунок 2.13 – 4 тон, слева эксперимент, f=7,88 Гц;  
справа расчёт, f=7,69 Гц 
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3. Моделирование контактного взаимодействия  
зубьев цилиндрической передачи 

Автор: Левадный Е. В. 

Организация: ДНУ имени Олеся Гончара 

E-mail: execut1oner@ua.fm 

Работа посвящена анализу контактных и изгибных напряжений в зацеплении 

цилиндрической прямозубой передачи. Для расчета была выбрана зубчатая пара с 

геометрическими параметрами, приведенными в таблице 3.1: 

Таблица 3.1 – Геометрические параметры зубчатой пары 

Наименование 
параметра 

Обозначение Шестерня Колесо 

Число зубьев z1, z2 20 20 

Модуль m (мм) 3 3 

Ширина венца b1, b2 (мм) 19.05 19.05 

Коэффициент 
смещения x1, x2 0 0 

Угол зацепления α, ° 20 20 

Модуль упругости E, МПа 2e5 2e5 

Коэффициент 
Пуассона μ 0.3 0.3 

Момент вращения T1 (Н ∗ м) 100   

1.1 Система координат модели и система единиц измерения 

Построение расчётной модели и обработка результатов производится в 

декартовой системе координат. При моделировании принята следующая система 

измерений: 

Таблица 3.2 – Система единиц измерения 

Длина Сила Масса Время Температура Плотность 

мм Н кг с ºC т\мм3 
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1.2  Геометрическая модель 

Откроем в дереве модели модуль PART. Для создания детали нажмите 

кнопку Create Part  или дважды щёлкните на значке  в дереве 

модели. 

 
Рисунок 3.1 – Создание геометрической модели 

В появившемся окне Create Part, дайте детали имя GEAR и примите 

следующие установки: 2D (двухмерного), Deformable (деформируемого) тела и 

Shell (оболочка) в качестве базового свойства. В текстовом поле Approximate size, 

наберите 200. Кликните Continue чтобы закрыть диалоговое окно. 

Профиль геометрической модели будет создан по контрольным точкам. 

Таблица 3.3 – Координаты контрольных точек 

x y 
25.92682 4.106405 
32.98354 1.042147 
32.0851 1.514966 
31.15739 1.927298 
30.20106 2.267758 
29.21739 2.517819 
27.20097 2.710907 
26.32292 3.192916 
32.538 1.285555 

31.62488 1.7293 
30.68275 2.11 
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29.71251 2.41 
28.21002 2.634196 
26.72692 2.888998 
26.04476 3.614353 

Для задания точек профиля, в режиме эскиза используйте команду  Create 

Isolated Point. Нажав на эту иконку, на текущей панели будет предложено ввести 

координаты точек, которые представлены в таблице 3.3. 

 
Рисунок 3.2 – Создание геометрической модели 

 

 

Затем необходимо обвести точки сплайном. Воспользовавшись 

инструментом Spline,  получаем следующую картину: 

 
Рисунок 3.3 – Создание геометрической модели 
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После этого создадим вспомогательную линию , проходящую через точки 

с координатами (0,0) и (10,0) 

Зеркально отобразим профиль относительно вновь созданной 

вспомогательной линии. Для этого наведите курсор мышки на инструмент  

Translate и зажмите левую кнопку мыши на этой иконке, появятся еще иконки, 

выберете – Mirror   . Далее укажем тип проводимой операции – 

Copy  , после этого выберем вспомогательную 

линию, относительно которой будет зеркально отображаться сплайн, после этого 

выделим сплайн, который необходимо отобразить. 

 
Рисунок 3.4 – Создание геометрической модели 

Затем соединим две верхние точки верхней и нижней части профиля с 

помощью инструмента  и получим: 
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Рисунок 3.5 – Создание геометрической модели 

Затем создадим точку с координатами (0,0) с помощью инструмента  и 

соединим крайние левые точки верхней и нижней части профиля, с вновь 

созданной точкой, с помощью инструмента . 

Получим: 

 
Рисунок 3.6 – Создание геометрической модели 

Теперь создадим окружность с центром в точке (0,0) и радиусом 17.5мм, с 

помощью инструмента Circle  и получим:  
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Рисунок 3.7 – Создание геометрической модели 

Затем, с помощью инструмента авто-обрезка - , удалим ненужные 

компоненты. 

 
Рисунок 3.8 – Создание геометрической модели 

Выходим из режима Эскиз,  нажав кнопку Done. 
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Рисунок 3.9 – Геометрическая модель 

1.3 Модель материала 

Для расчёта достаточно задания только модуля Юнга и коэффициента 

Пуассона. 

Создадим материал с необходимыми свойствами. В Дереве Модели дважды 

кликните по контейнеру Materials, чтобы создать новый материал. В 

появившемся окне Edit Material, зададим имя Steel. В меню редактора выберем 

Mechanical=>Elasticity=>Elastic и введем значение коэффициента Пуассона 

v=0.3. и модуля Юнга E=2e5 MПa (Рисунок 3.10). 

 
Рисунок 3.10 – Определение модели материала 

Теперь перейдём к определению сечения. Открываем диалоговой окно Create 

Section (вызов возможен либо из Дерева модели, либо через иконку ). В 

диалоговом окне Create Section присвоим сечению имя GEAR. Выберите в 
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соответствующих списках Solid, Homogoneous и кликните Continue. В 

появившемся окне редактора сечений Edit Section,  в качестве материала 

необходимо указать созданный ранее материал Steel, а также в графе Plain 

stress/strain thickness укажите значение ширины венца 19.05 мм. 

 

Рисунок 3.12 – Создание сечения геометрической модели 

Следующим шагом присвоим построенное сечение ранее созданной 

геометрии зуба. Для этого используем иконку  Assign Section в текущей панели 

инструментов (либо дважды нажимаем по элементу в дереве модели, либо 

используем команды меню Assign=>Section). С помощью мыши выделите 

геометрию зуба, она будет подсвечена красным цветом. Нажмите Done. В 

появившемся окне, выберите созданное сечение и подтвердите выбор нажатием 

кнопки ОК. 

 
Рисунок 3.12 – Присвоение сечения геометрической модели 
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1.4 Сборка 

Перейдём к модулю ASSEMBLY. Для создания сборочной единицы 

необходимо нажать на иконку Create Part Instance  (либо в дереве модели 

дважды кликнуть по элементу , либо воспользоваться  командами: меню 

Instance => Create). Появится окно со списком созданных деталей Parts. 

В нашем случае деталь всего одна, выберем ее – она будет выделена красным 

цветом. В разделе Instance Type укажите Independent и подтвердите выбор, нажав 

ОК. 

 
Рисунок 3.13 – Создание экземпляра сборки 

 

Также нам необходимо добавить еще 1 зуб в сборку. Для этого повторим 

вышеописаный пункт по добавлению компонентов в сборку и нажмем кнопку 

Auto-offset from other instances 

 
Рисунок 3.14 – Создание экземпляра сборки 
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Рисунок 3.15 – Создание экземпляра сборки 

Далее необходимо правильно расположить зубья в зацеплении, 

переместим 2 зуб на требуемое расстояние. Выберем инструмент Translate - 

, выберем точку, как показано на рисунке и введем координаты переноса 

(92.98354, 0.0) 

 
Рисунок 3.16 – Создание экземпляра сборки 

Получим: 

 
Рисунок 3.17 – Создание экземпляра сборки 

Следующим этапом нужно развернуть 2 зуб. Для этого воспользуемся 
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инструментом Rotate . Затем выделим 2 зуб, - Done, введем координаты 

точки, вокруг которой будет происходить вращение (60,0,0), и зададим угол 

равный 171º. Нажмем Enter. 

Окончательная сборка имеет следующий вид: 

 
Рисунок 3.18 – Создание экземпляра сборки 

 

1.5 Определение процедуры анализа 

В Дереве Модели дважды кликните по контейнеру Step. В окне Create Step 

задайте имя нового шага анализа – Contact. Задаём статический расчёт Static, 

General и кликните Continue (Рисунок 3.19). 

 
Рисунок 3.19 – Определение процедуры анализа 

В появившемся окне Edit Step, включим нелинейные геометрические 

эффекты Nlgeom – On. Во вкладке Automatic stabilization выберите Specify 
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dissipated energy fraction, остальные настройки решателя оставьте без изменений 

и нажмите ОК. 

 
Рисунок 3.20 – Определение процедуры анализа 

1.6 Контактные взаимодействия 

Зададим контактные взаимодействия между зубьями. Для этого в окне Create 

Interaction (модуль Interaction) выберите Surface-to-surface contact (Standard) на 

шаге Contact и нажмите Continue (Рисунок 3.21). 

 
Рисунок 3.21 – Задание контактных взаимодействий 

После выбора опций и нажатия кнопки Continue на экране задаются 

контактные зоны, главная (master) и подчиненная (slave). Сначала выбирается 

главная поверхность. Из двух контактных поверхностей главная поверхность 
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должна быть более жесткой, в данной задаче верхний зуб. На экране выбранная 

поверхность становится красной. Затем выбирается подчиненная поверхность, 

она будет после выбора малиновой. 

 
Рисунок 3.22 – Задание контактных взаимодействий 

Для задания механических свойств соединения, необходимо в окне Edit 

Interaction нажать кнопку Create или кнопку Create Interaction Property. 

Появляется одноименное окно, в котором задается тип взаимодействия – контакт 

Contact. После задания типа взаимодействия, необходимо  определить свойства 

контактного взаимодействия в окне Edit Contact Property, возникающем по 

нажатию кнопки Continue. В данной задаче достаточно определить нормальное 

взаимодействие. 

Это свойство задаётся при использовании команд меню  Mechanical – 

Normal Behavior.  

Во вкладке Normal Behavior оставьте настройки, используемые по 

умолчанию. Закройте все окна нажатием кнопок ОК. 
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Рисунок 3.23 – Задание контактных взаимодействий 

Теперь создадим две Reference point с помощью кнопки . 

Координаты точек: RP1 (0, 0); RP2 (60, 0). 

Далее нужно связать созданные точки с геометрией зубьев. Воспользуемся 

кнопкой Constraints и выберем Coupling. 

 
Рисунок 3.24 – Создание связей 

Сначала выбираем созданную нами ранее Reference point с координатами 

(0,0), а затем близлежащую грань к этой точке: 



 

Современные технологии - в промышленность 

Программное обеспечение 
Инженерный консалтинг 

Вычислительная техника 
Измерительное оборудование 

 
 

55 
 

 
Рисунок 3.25 – Создание связей 

 
Рисунок 3.26 – Создание связей 

Повторяем все описанное выше для задания взаимосвязи второй Reference 

point с геометрией зуба: 

В дереве модели - Constraints и выберем Coupling: 

 
Рисунок 3.27– Создание связей 
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Выбираем созданную нами ранее Reference point с координатами (60,0) а 

затем близлежащую грань к этой точке 

Рисунок 3.28 – Создание связей 

 
Рисунок 3.29 – Создание связей 

 
Рисунок 3.30 – Создание связей 

 

1.7 Нагрузки и граничные условия 

Для задания граничных условий на зубьях перейдём в модуль Load. В окне 

Create Boundary Condition выберите во вкладке STEP- имя шага CONTACT и 

затем - Displacement/rotation. 
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Рисунок 3.31 – Задание граничных условий 

Нажмите Continue, выберите левую Reference point (координаты (0,0)) и 

жестко закрепите по всем степеням свободы. 

 
Рисунок 3.32 – Задание граничных условий 

Для задания граничных условий на правом зубе повторим вышеописанные 

действия, за исключением последнего пункта. Во вкладке Displacement/rotation 

для правой Reference point (та, которая с координатами (60,0)) зафиксируем все 

степени свободы, кроме вращения вокруг оси Z. 



 

Современные технологии - в промышленность 

Программное обеспечение 
Инженерный консалтинг 

Вычислительная техника 
Измерительное оборудование 

 
 

58 
 

 
Рисунок 3.33 – Задание граничных условий 

Теперь зайдем в Loads - , выберем Reference point (та, которая с 

координатами (0,0)), затем выберите во вкладке STEP- имя шага Load, затем – 

Moment и введем значение напротив CM3 = 100000. 

 
Рисунок 3.34 – Задание граничных условий 
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1.8 Конечно-элементная модель 

Теперь перейдем в модуль Mesh. Зададим форму и алгоритм построения 

конечно-элементной сетки. Для этого в окне Mesh Controls (Mesh=>Controls) 

выберите форму элемента Quad-dominated, способ Free и алгоритм Medial axis. 

 
Рисунок 3.35 – Определение формы и метода построения кэ сетки 

 При расчёте данной задачи необходим определённый тип конечных 

элементов. В окне Element Type (Mesh => Element Type) выберите следующий 

тип КЭ – CPS4. И нажмите OK. 

 
Рисунок 3.36– Выбор типа конечных элементов 
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С помощью команды  Seed Part Instance, выделим оба зуба и зададим 

примерный размер элемента 0.5. Нажмите ОК. 

 

Рисунок 3.37 – Построение КЭ сетки 

Теперь с помощью команды Mesh Part Instance выделите всю модель и 

произведите разбиение (внизу на текущей панели нажмите на кнопку Done): 

 

Рисунок 3.38 – Построение КЭ сетки 
1.9 Запуск на расчет 

Перейдите в модуль JOB. С помощью иконки  Create Job  (либо команд 

меню  Job => Create или дважды кликнув по элементу  в дереве модели) создайте 

задание на расчёт. В появившемся  окне Create Job,  присвойте заданию имя 

GearJob. 
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Рисунок 3.39 – Определение задания на расчет 

Для продолжения нажмите кнопку Continue. Задание на расчёт 

сформировано. Чтоб запустить расчёт, вызовите  Job Manager (рис. 6.15) (либо 

раскройте элемент дерева модели, кликните правой кнопкой по заданию 

GearJob и выберите Submit, либо командами меню Job => Manager). 

В появившемся окне Job Manager нажмите Submit. Надпись Running 

говорит о том, что расчет запустился. 

 
Рисунок 3.40 – Вызов Job Manager 

1.10 Анализ полученных результатов 

На рисунке 3.41 представлено поле распределения напряжений по Мизесу. 
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Рисунок 3.41 – Распределение поля напряжений 

 

С помощью иконки Contour Plot Option  вы можете вывести значения 

максимальных и минимальных значений напряжений. Для этого в окне Contour 

Plot Options выберите вкладку Limits и поставьте галочки напротив Show location, 

как на рисунке 3.42. 

 
Рисунок 3.42 – Contour Plot Options 

С помощью инструмента  Probe Values вы можете проконтролировать 

значения напряжений в зонах контакта и изгиба в каждом узле модели. 
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Рисунок 3.43 – Работа с инструментом Probe Values 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
  



 

Современные технологии - в промышленность 

Программное обеспечение 
Инженерный консалтинг 

Вычислительная техника 
Измерительное оборудование 

 
 

64 
 

4. Моделирование процесса волочения с противонатяжением 
Автор: Бойко А. Б. 

Организация: ФГБОУ ВПО "Магнитогорский ГТУ им Г. И. Носова" 

E-mail: boyko.ab@mail.ru 

В рамках данной задачи производится моделирование процесса волочения 

углеродистой проволоки. Анализируется влияние величины противонатяжения на 

вероятность обрыва проволоки в процессе волочения. На рисунке 4.1 

представлена принципиальная схема задачи. 

 
Рисунок 4.1 – Постановка задачи 

Граничные условия: 

1. Ограничение на перемещения волоки через управляющую точку А; 

2. Задание постоянной скорости перемещения левого торца (ВС) 

проволоки - 𝑣2 = 2.5 м\с; 

3. Приложение давления к правому торцу проволоки. 

1.1 Система координат модели и система единиц измерения 

Построение расчётной модели и обработка результатов производится в 

декартовой системе координат.  

При моделировании принята следующая система измерений – SI. 

Таблица 4.1 – Система единиц измерения 

Длина Сила Масса Время Давление Плотность 

𝑚 𝑁 𝑘𝑔 s Па kg\m3 
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1.2 Геометрическая модель 

Создадим геометрическую модель проволоки. Откроем в дереве модели 

модуль PART. Для создания детали нажмите кнопку Create Part   или дважды 

щёлкните на значке  в дереве модели. 

 
Рисунок 4.2 – Создание геометрической модели 

В появившемся окне Create Part (Рисунок 4.2) присваиваем имя детали  Wire 

(проволока) и принимаем следующие установки: Axisymmetric 

(осесимметричное), Deformable (деформируемое) и Shell (оболочка) в качестве 

базового свойства. Нажимаем Continue, чтобы закрыть диалоговое окно. 

  

Рисунок 4.3 – Построение эскиза модели 

В появившемся рабочем поле, воспользовавшись инструментом , создаём 

эскиз, представленный на рисунке 4.3. Координаты контрольных точек эскиза: (0, 
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0.005); (0.0029, 0.005); (0.0029, 0.01); (0.00325, 0.02); (0.00325, 0.05): (0.0, 0.05); 

(0.0, 0.005). После задания координат каждой точки, подтверждаем свой выбор 

клавишей Enter (или средней кнопкой мыши). В случае ошибки можно 

произвести отмену действия при помощи кнопки Cancel. Выходим из режима 

Эскиз,  нажав кнопку Done.  

  
Рисунок 4.4 – Создание 
геометрической модели 

Рисунок 4.5 – Создание 
геометрических примитивов 

С помощью инструмента Partition Face , произведём разбиение 

геометрической модели сечения проволоки на примитивы (Рисунок 4.5). 

Создадим геометрическую модель волоки. Откроем в дереве модели модуль 

PART. Для создания детали нажмите кнопку Create Part   или дважды 

щёлкните на значке  в дереве модели. 

В появившемся окне Create Part (рисунок 2.4) присваиваем имя детали  Die 

(волока) и принимаем следующие установки: Axisymmetric (осесимметричное), 

Discrete rigid (жёсткое) и Wire (балка) в качестве базового свойства. Нажимаем 

Continue, чтобы закрыть диалоговое окно и перейди в модуль Sketch. 
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Рисунок 4.6 – Построение эскиза модели волоки 

В появившемся рабочем поле, воспользовавшись инструментом , создаём 

эскиз, представленный на рисунке 4.6. Координаты контрольных точек эскиза: 

(0.005, 0.0); (0.0029, 0.003); (0.0029, 0.0055); (0.00453, 0.021). После задания 

координат каждой точки, подтверждаем свой выбор клавишей Enter (или средней 

кнопкой мыши). В случае ошибки можно произвести отмену действия при 

помощи кнопки Cancel. Выходим из режима Эскиз,  нажав кнопку Done.  

Во вкладке Tools выбираем Reference Point и создаем опорную точку  на 

поверхности волоки (рисунок 4.7). 

 
Рисунок 4.7 – Создание опорной точки 
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1.3 Модель материала 

Моделирование будет проводиться с использованием упруго пластической 

модели поведения материала. Для учёта вероятного обрыва проволоки введена 

модель разрушения материала. Свойства материала проволоки представлены в 

таблице 4.2 

Таблица 4.2 – Свойства материала Steel 

Параметр Значение 

Плотность, кг/м3 7800 

Модуль Юнга, Па 210∙109 

Коэффициент Пуассона 0.28 

Предел текучести, Па 732∙106 1079∙106 

Пластические деформации 0 0.08 

Предельная деформация на разрыв 0.25 

 Создадим материал проволоки с необходимыми свойствами. В Дереве 

Модели дважды кликаем по контейнеру Materials, чтобы создать новый материал. 

В появившемся окне Edit Material задаем имя Steel. В меню редактора выбираем 

General=>Density и вводим значение 7800 кг/м3.  

  
Рисунок 4.8 – Упругая модель Рисунок 4.9 – Пластичность 
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Для задания значений упругих свойств материала выбираем Mechanical => 

Elasticity => Elastic и вводим значения модуля упругости 210∙109 Па и 

коэффициента Пуассона 0.3. Затем задаём пластические свойства: Mechanical => 

Plasticity => Plastic - вводим значения предела текучести 732∙106 Па с 

соответствующей деформацией 0; временного сопротивления 1079∙106 Па с 

соответствующей деформацией 0.08.  

Для моделирования возможного обрыва проволоки используется модель 

разрушения Бао-Вербицки (Ductile damage). Mechanical => Damage for Ductile 

Metals => Ductile Damage, вводим значение максимальной пластической 

деформации 0.25;  Stress Triaxility  0,33, скорости деформации 1 (рисунок 4.10). 

  
Рисунок 4.10 – Определение модели разрушения материала 

После ввода параметров инициализации необходимо указать параметры 

развития разрушения, нажав на кнопку  Suboptions (рисунок 4.10). Изменяем тип 

на энергетический (Energy) и вводим значение энергии разрушения 30476 

(рисунок 4.11). 
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Рисунок 4.11 – Определение энергетического критерия развития разрушений 

Теперь переходим к определению сечения. Открываем диалоговой окно 

Create Section (вызов возможен либо из Дерева модели, либо через иконку  ). В 

диалоговом окне Create Section присваиваем сечению имя Steel. Выбираем в 

соответствующих списках Solid, Homogoneous и нажимаем Continue. В 

появившемся окне редактора сечений Edit Section,  в качестве материала 

необходимо указать созданный ранее материал Steel. Присваиваем созданное 

сечение геометрической модели проволоки Wire.  

1.4 Сборка  

Перейдём в модуль ASSEMBLY. Для создания сборочной единицы 

необходимо нажать на иконку Create Part Instance  (либо в дереве модели 

дважды кликнуть по элементу  , либо воспользоваться  командами: меню 

Instance => Create). Появится окно со списком созданных деталей Parts. В нашем 

случае детали две, выберем их и подтвердим выбор, нажав ОК. 
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Рисунок 4.12 – Создание экземпляра сборки 

1.5 Определение процедуры анализа 

В Дереве Модели дважды кликаем по контейнеру Step. В появившемся меню, 

выбираем Dynamic Explicit и нажимаем Continue (Рисунок 4.13). В окне Edit Step, 

устанавливаем временной период 0.02 сек и нажимаем ОK. 

  

Рисунок 4.13 – Определение процедуры анализа 

Сформируем запрос на вывод полевых переменных. Раскрываем дерево 

 и нажимаем на F-Output-1. Установим частоту записи - 200 и во 
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вкладке State/Field/User/Time установим флажок напротив параметра STATUS 

для визуализации разрушенных элементов (Рисунок 4.14) и DMICRT (критерий 

вязкого разрушения). 

  
Рисунок 4.14 – Запрос на вывод данных 

1.6 Контактные взаимодействия 

Определим контактные взаимодействия между поверхностью проволоки и 

волоки. Перейдём в модуль Interaction. Создадим новое контактное 

взаимодействие с помощью команды Create Interaction (Рисунок 4.15). Способ 

задания - Surface-to-surface contact.  

 
Рисунок 4.15 – Задание контактных взаимодействий 
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Выберем Master поверхность – поверхность волоки. Цветовым кодированием 

обозначена сторона волоки, к которой будут применены контактные ограничения 

(в нашем случае - Magenta).  

  

Рисунок 4.16 – Задание контактных 
взаимодействий 

Рисунок 4.17 – Задание контактных 
взаимодействий 

Далее выберем Slave поверхность – боковая поверхность проволоки 

(Рисунок 4.17). 

  

Рисунок 4.18 – Создание свойств контактного взаимодействия 
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Зададим свойства контактного взаимодействия, нажав на иконку . 

Определим модель фрикционного взаимодействия: Contact=>Tangential Behavior.  

После этого, в появившемся окне Edit Contact Property, во вкладке выбираем 

Penalty и зададим коэффициент трения 0.01. 

 
Рисунок 4.19 – Задание коэффициента трения 

1.7 Нагрузки и граничные условия 

Для имитации противонатяжения приложим к верхнему торцу проволоки 

давление. Для этого перейдём в модуль Load, создадим нагрузку ,  выберем 

тип нагрузки Pressure. Далее необходимо выбрать верхний торец проволоки 

(область приложения давления) и ввести величину нагрузки 500∙106 Па (рисунок 

4.20). 

  

Рисунок 4.20 – Приложение нагрузки 
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Теперь перейдём к заданию скорости перемещения проволоки. В окне Create 

Boundary Condition выберем тип граничных условий – Velocity/Angular velocity. 

Выделим нижний торец проволоки и зададим скорость перемещения - 𝑣2 =

− 2.5 м\с. 

  
Рисунок 4.21 – Определение скорости перемещения проволоки 

Создадим новое ГУ, ограничивающее перемещение волоки. В окне Create 

Boundary Condition выбираем тип ГУ: Symmetry/Antisymmetry/Encastre. 

Нажимаем Continue и выбираем  опорную точку RP на поверхности волоки. 

  
Рисунок 4.22 – Определение ГУ волоки 
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1.8 Конечно-элементная модель 

Перейдём в модуль Mesh. Разбиение на конечные элементы производим для 

каждой детали. Нажав курсором на Part, выбираем объект Wire. В появившемся 

меню устанавливаем приблизительный размер элемента 0.00045 (Рисунок 4.23). 

Производим разбиение, нажав на кнопку . 

 
 

Рисунок 4.23 – Создание КЭ модели проволоки 

Аналогичным образом производим создание КЭ модели волоки. Размер 

элемента 0.0016. 

  
Рисунок 4.24 – Создание КЭ модели волоки 
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1.9 Запуск на расчёт 

Перейдите в модуль  JOB (Рисунок 4.25). С помощью иконки  Create Job 

(либо команд меню  Job => Create или дважды кликнув по элементу в дереве 

модели) создаём задание на расчёт. В появившемся  окне Create Job, присваиваем 

заданию имя Drawing. 

 
Рисунок 4.25 – Определение задания на расчёт 

Для продолжения нажимаем кнопку Continue. Задание на расчёт 

сформировано. Чтоб запустить расчёт, вызываем  Job Manager (либо 

раскрываем элемент дерева модели, кликаем правой кнопкой по заданию 

Drawing и выбираем Submit, либо командами меню Job => Manager). 

В появившемся окне Job Manager нажимаем Submit. Надпись Running 

говорит о том, что расчёт запустился. 

1.10 Анализ полученных результатов 

С помощью функции Sweep elements возможно представление результатов 

моделирования в 3D постановке (Рисунок 4.26)  

 
Рисунок 4.26 – Визуализация результатов 
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На рисунках 4.27 – 4.28 представлены результаты моделирования: 

эквивалентные напряжения по Мизесу и эквивалентные пластические 

деформации. При величине противонатяжения – 500 𝑀𝑃𝑎 разрыва проволоки не 

происходит. 

  
Рисунок 4.27 – Распределение 

эквивалентных напряжений по Мизесу 

Рисунок 4.28 – Эквивалентные 

пластические деформации 

При увеличении величины противонатяжения до 700 𝑀𝑃𝑎, происходит 

разрыв проволоки. 

  

Рисунок 2.29 – Распределение 

эквивалентных напряжений по Мизесу 

Рисунок 2.30 – Распределение 

параметра повреждаемости 
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5. Моделирование роста трещины с применением  
технологии XFEM 

Автор: Остапов А. В. 

Организация: ННЦ Харьковский физико-технический институт 

E-mail: ostapov@kipt.kharkov.ua 

В рамках данной задачи производится нахождение полей напряжений в 

образце из Zr-1%Nb для испытаний на замедленное гидридное растрескивание, с 

учетом приложенной нагрузки через приспособления из инструментальной стали 

(через контакт), в момент инициирования трещины и ее дальнейшего 

распространения. На рисунке 5.1 представлена принципиальная схема задачи. 

Образец находится в плотной посадке на двух идентичных приспособлениях, 

к которым приложена сила. Образец имеет 2 пары надрезов для создания 

концентрации напряжений. Дополнительно предполагается, что в образце имеется 

начальная трещина, которая начинается со стороны коротких надрезов, 

расположенных ближе к приложенной силе (трещина не показана). 

   

Образец Приспособления Общая схема 
Рисунок 5.1 − Принципиальная схема задачи 

1.1  Система координат модели и система единиц измерения 

Построение расчетной модели и обработка результатов производится в 

декартовой системе координат. 

При моделировании принята следующая система измерений –Si (Табл. 5.1). 

Таблица 5.1 – Система единиц измерения 

Длина Сила Масса Время Давление Плотность 

𝑚 𝑁 𝑘𝑔 s Па kg\m3 

1.2   Геометрическая модель 
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Данная задача включает три части: образец (трубка), приспособление и 

трещина. В виду симметрии геометрической модели и нагрузки относительно 

вертикальной плоскости, проходящей через ось образца, достаточно рассмотреть 

только половину всей модели.  

Геометрическая модель трубки (PLT-specimen) представлена на рисунке 5.2. 

Это трехмерное (3D) деформируемое тело (тип Deformable), в качестве базового 

свойства выбираем твердое тело (Solid). Модель соответствует требованиям 

МАГАТЭ: трубка длиной 13 мм, диаметром 9,15 мм, толщиной стенки 0,7 мм и с 

двумя аксиальными надрезами с каждого из двух краев. Длина коротких надрезов 

1,5 мм (ближе к приложенной силе), длинных – 2,0 мм. Ширина надрезов 0,5 мм.  

 
Рисунок 5.2 − Геометрическая модель образца 

На рисунке 5.3а представлен эскиз поперечного сечения образца с центром в 

точке (0,0) и двумя окружностями с радиусами 3,875 мм и 4,575 мм (желтые 

линии показывают надрез и используются позднее). Цилиндрический образец 

строится путем экструзии на длину 13 мм – длина образца (рис. 5.3б). Далее 

нужно создать надрез с помощью кнопки меню Create Cut: Extrude. Выбирается 

торец образца и затем, в режиме построения эскиза, строится профиль надреза 

толщиной 0,5 мм (рис. 5.3а). В окне Edit Cut Extrusion выбираем тип экструзии – 

Blind и задаем глубину экструзии – 2 мм. Аналогично поступаем с надрезом с 

другого торца образца: здесь нужно задать глубину экструзии 1,5 мм. На рисунке 
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5.3в представлен образец с вырезами с двух краев, глубиной 2 мм и 1,5 мм. На 

рисунке 5.3г представлено разбиение геометрии на геометрические примитивы, 

созданные с помощью кнопки Partition Cell. Разбиение необходимо выполнить 

для создания более регулярной сетки, а также для размещения начальной 

трещины. Начальная трещина начинается от края короткого надреза, длиной 1,5 

мм, и входит в образец на глубину 1,5 мм. Для размещения вершины начальной 

трещины создаем дополнительное разбиение, перпендикулярное оси образца. 

Разбиение отстоит на расстоянии 1,5 мм от края короткого надреза (рис. 5.3г). 

  
а б 

  
в г 

Рисунок 5.3 – Эскиз сечения (а) и 3D геометрической модели образца (б,в,г) 

Геометрическая модель приспособления (PLT-fixture) представлена на 

рисунке 5.4. Одно приспособление представляет собой половину цилиндра 

радиусом 3,87 мм, высотой 20 мм. По бокам приспособление срезано 
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вертикальными плоскостями – высота этих срезов 0.5 мм. Так как приспособление 

выполнено из стали, то будем считать, что приспособление недеформируемое 

(3D) тело типа Analytical Rigid (жесткое аналитическое).  

 
Рисунок 5.4 − Геометрическая модель приспособления 

На рисунке 5.5а представлен эскиз поперечного сечения приспособления с 

центром в точке (0,0). В поперечное сечение мы включаем только поверхность, по 

которой приспособление будет контактировать с образцом. Трехмерная модель 

приспособления получается путем экструзии на длину 20 мм (рис. 5.5б). Нижнее 

приспособление можно получить путем копирования уже созданного верхнего 

приспособления. Копию можно создать с помощью зеркального отображения 

верхнего приспособления относительно вертикальной плоскости поперечного 

сечения – в нашем случае это плоскость YZ. Нижнее приспособление показано на 

рис. 5.5в. 

Геометрическая модель начальной трещины - это трехмерное (3D) 

деформируемое тело (тип Deformable), в качестве базового свойства мы 

выбираем оболочку (Shell) типа Planar (плоский). Принимаем длину начальной 

трещины равной 1,5 мм. Для удобства выбора плоскости трещины при ее 

определении желательно, чтобы трещина выступала за пределы образца. Поэтому 

мы задаем длину трещины 2 мм. Ширина трещины должна быть равна толщине 

образца (0.7 мм), но для удобства выбора плоскости трещины мы принимаем ее 

ширину 10 мм. 
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На рисунке 5.6а представлен эскиз модели трещины 2х10 мм, а на рисунке 

5.6б представлена 3D геометрическая модель этой трещины. 

  
а б 

в 

 
Рисунок 5.5 − Эскиз детали верхнего и нижнего приспособления 

 

 

 

 
а б 

Рисунок 5.6 – Эскиз (а) и 3D геометрическая модель начальной 

трещины (б) 

1.3 Модель материала 



 

Современные технологии - в промышленность 

Программное обеспечение 
Инженерный консалтинг 

Вычислительная техника 
Измерительное оборудование 

 
 

84 
 

Была выбрана линейно-упругая модель материала. Механические свойства 

циркония (материала образца), используемые в модели, приведены в Таблице 5.2. 

Задание материала с именем Zr1Nb представлено на рисунке 5.7. 

Таблица 5.2 – Характеристики материала образца 

Модуль Юнга, ГПа 93,24  

Коэффициент Пуассона 0,41  

Коэффициент вязкости, Па*с 1∙10-6 

Энергия разрушения, Н/м 21719 

Макс. напряжение, Па 1,5∙108 

Технология моделирования роста трещины – XFEM (eXtended Finite Element 

Method) или расширенный метод конечных элементов. Внедрение этого метода 

дает возможность моделировать рост трещины по произвольным путям, не 

зависящим от границ элементов. 

Трещина зарождается в месте максимальной концентрации растягивающих 

напряжений. Направление распространения трещины перпендикулярно 

максимальному главному напряжению. В качестве критерия инициирования 

трещины выбрано условие превышения заданного уровня напряжений (силовой 

критерий), а в качестве критерия распространения трещины – энергетический 

критерий (скорость высвобождения энергии). Скорость высвобождения энергии 

при растягивающей нагрузке определяется по соотношению: 

GIC = KIC
2/E, 

где KIC – критический коэффициент интенсивности напряжений, а E – модуль 

Юнга. В качестве критического напряжения (Maxps Damage) выбрано значение 

150 МПа (рис. 5.7).  



 

Современные технологии - в промышленность 

Программное обеспечение 
Инженерный консалтинг 

Вычислительная техника 
Измерительное оборудование 

 
 

85 
 

  

 
Рисунок 5.7– Определение материала Zr1Nb 
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К образцу были применены свойства материала Zr-1%Nb. Для этого было 

создано сечение (Section) с параметрами Solid, Homogeneous и материалом 

Zr1Nb. Затем образцу через Assign Section было присвоено созданное сечение. 

1.3  Сборка 

На рисунке 5.8 представлена сборка данной задачи, состоящая из образца, 

плотно посаженного на две соприкасающиеся поверхности приспособлений. Для 

правильного позиционирования сборки нижнее приспособление надо 

предварительно повернуть на 180° при помощи кнопки Rotate Instance. Обратим 

внимание на то, что один из торцов приспособлений совпадает с плоскостью 

торца образца со стороны длинного надреза. Другой торец приспособлений будет 

выступать за пределы образца. Начальная трещина была помещена в сборку при 

помощи кнопки Translate Instance таким образом, чтобы она была заглублена в 

образец на длину 1.5 мм, начиная от края короткого надреза (для привязки 

вершины трещины к образцу удобно использовать наше разбиение образца). 

Также желательно, чтобы трещина частично выступала за образец, для удобства 

определения ее поверхности (рис. 5.8б).  

Трещина была определена в Engineering Features→Cracks. Тип трещины 

XFEM (рис. 5.9а). В качестве области распространения была выбрана вся модель 

образца (рис. 5.9б), также была выбрана область начальной трещины – 

прямоугольная пластина, которую мы только что разместили в сборке. 

Контактные свойства можно не задавать, так как мы будем предполагать, что 

поверхности трещины никак не контактируют между собой. 
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а б 

Рис. 5.8 Сборка  
а – образец и приспособления, б – позиционирование трещины 

 

а 

 

б

б 

 
Рисунок 5.9 – Определение трещины, а – параметры 

трещины, б – 3D представление 

1.4 Определение процедуры анализа 
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Для решения данной задачи создаем в контейнере Steps статический шаг (тип 

Static, General). Параметры этого шага указаны в Таблице 5.3. Так как 

перемещения поверхностей трещины могут быть большими, то лучше учесть 

геометрическую нелинейность. Для решения проблем сходимости было внесено 

изменение в количество попыток при решении проблем сходимости. Для этого в 

главном меню для созданного шага находим Other→General Solution 

Controls→Edit. Принимаем условия, нажав на кнопку Continue. В открывшемся 

окне General Solution Controls Editor меняем параметр IA с 5 на 20 (рис. 5.10). 

Таблица 5.3 – Параметры решателя 

Характеристики шага Значение 

Полное время шага 1 

Геометрическая нелинейность ON 

Макс. чисто инкрементов 105 

Начальный размер инкремента 5E-2 

Минимальный размер инкремента 5E-7 

Максимальный размер инкремента 5E-2 

Число попыток при решении 
проблем сходимости 

20 

 

 
Рисунок 5.10 – Настройки решателя 
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Сформируем запрос на вывод полевых переменных. Раскрываем дерево 

 и нажимаем на F-Output-1. Помимо переменных по умолчанию, 

запросим вывод PHILSM, PSILSM, STATUSXFEM (вкладка Failure/Fracture). 

1.5  Контактные взаимодействия 

Для создания контактных взаимодействий между поверхностями 

приспособлений и образцом создадим сначала свойство контактного 

взаимодействия (контейнер Interaction Properties). Задаем коэффициент трения 

0,5 и параметр поведения по нормали − «Жесткий» контакт (Hard Contact) (рис. 

5.11). Далее, с помощью опции Find Contact Pairs, вызываемой через контекстное 

меню контейнера Interaction, автоматически находим контактные пары. 

Уменьшая параметр Separation Tolerance до 10-8, можно добиться, чтобы были 

найдены только 2 контактные пары (рис. 5.12). Это будет соответствовать 

контакту верхнего приспособления с внутренней поверхностью образца и 

контакту нижнего приспособления с внутренней поверхностью образца (рис. 

5.13). Далее после нажатия кнопки OK найденные контактные пары оказываются 

в контейнере Interaction.  

 

 

Рисунок 5.11 – Определение свойств контактного взаимодействия 
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Рисунок 5.12 – Автоматический поиск контактных взаимодействий 

В контейнере Interaction выбираем первое взаимодействие и в открывшемся 

окне Edit Interaction оставляем все параметры по умолчанию, включая отсутствие 

корректировки положения поверхностей при их контакте (No Adjustment). В этом 

же окне в качестве свойств контактного взаимодействия (Contact Interaction 

Property) выбираем свойства с именем Friction, определенные выше. Такие же 

свойства задаем для второго взаимодействия. 

В результате были созданы два контактных взаимодействия (рис. 5.13): 

1. Контактное взаимодействие верхнего приспособления с внутренней 

поверхностью образца (рис. 5.13а). 

2. Контактное взаимодействие нижнего приспособления с внутренней 

поверхностью образца (рис. 5.13б). 
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а б 

Рисунок 5.13 − Контактное взаимодействие поверхностей верхнего (а) и 

нижнего (б) приспособления с внутренней поверхностью образца 

Чтобы задать недеформируемое тело приспособления с помощью 

аналитической поверхности нужно указать ссылочную точку (Reference Point), 

саму аналитическую поверхность, а затем создать ограничение – Rigid Body. У 

каждого твердого тела должна быть своя собственная ссылочная точка. По 

перемещениям и поворотам ссылочной точки можно определить перемещение 

всего твердого тела. К ссылочной точке можно прикладывать перемещения, 

повороты, сосредоточенные силы, сосредоточенные моменты. 

Создадим ссылочную точку для верхнего приспособления, лежащую на оси 

образца, в плоскости торца приспособления со стороны длинного надреза. Такое 

положение точки удобно, так как потом мы приложим нулевые перемещения 

именно в этой точке. Создать ссылочную точку можно, например, с помощью 

кнопки Create Reference Point в модуле Interaction. После задания точки, она 

появится в контейнере Features.  

Далее определяем первое ограничение. В контейнере Ограничения 

(Constraints) выбираем тип ограничения: Твердое тело (Rigid Body). В 

открывшемся окне выбираем тип области – Аналитическая поверхность 

(Analytical Surface), также в рабочем поле выбираем саму поверхность и затем 
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выбираем ссылочную точку (Reference Point), как показано на рисунке 5.14а. 

Нажимаем кнопку ОК. Первое ограничение будет в результате создано. 

 Вторая ссылочная точка для нижнего приспособления имеет те же самые 

координаты в пространстве. Для удобства можно временно скрыть первую 

ссылочную точку с помощью контекстного меню точки (команда Suppress). 

Помещаем вторую ссылочную точку в то же место, что и первая точка (рис. 

5.14б). Далее создаем второе ограничение, для нижнего приспособления, 

аналогично первому ограничению. После этого можно вернуть изображение 

первой ссылочной точки с помощью контекстного меню точки (команда Resume). 

  

а б 

Рисунок 5.14 – Определение твердого тела приспособлений с помощью 

ограничений 

  1.6 Нагрузки и граничные условия 

На рисунке 5.15 представлены соответствующие эксперименту граничные 

условия для образца – образец жестко закреплен (Displacement/Rotation U1 = …= 

UR3 = 0) по краю длинного надреза в 2 мм. Также задаются условия симметрии 

деформаций на вертикальной плоскости симметрии образца (XSYMM: U1 = UR2 = 

UR3 = 0). Два приспособления крепятся в своих ссылочных точках. Для каждой из 

ссылочных точек мы задаем нулевые перемещения (U1 = U2 = U3 = 0) и нулевые 

повороты вокруг осей Y и Z (UR2 = UR3 = 0) (рис. 5.16). Задаем далее нагрузку 

для ссылочных точек в виде сосредоточенного момента. Для верхнего 
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приспособления момент равен 5.5 Н∙м, для нижнего приспособления момент 

равен −5.5 Н∙м (рис. 5.16). В результате приспособления будут вращаться в 

разных направлениях. Надо отметить, что приложенные моменты заменяют 

действие сосредоточенной силы, приложенной на другом торце к 

приспособлению. Момент будет равен произведению силы на плечо – в данном 

случае, длина приспособления. 

 
Рисунок 5.15 − Граничные условия для образца 

 

  
а б 

Рисунок 5.16 − Граничные условия и нагрузки для приспособлений,  

а – верхнего, б – нижнего 

1.7 Конечно-элементная модель 

По предоставленной 3D модели образца была построена конечно-элементная 

сетка, состоящая из 584 элементов (C3D8R) (990 узлов) (рис. 5.17). Глобальный 
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размер сетки равен 0.65 мм. Также задаем локальный размер сетки путем задания 

количества элементов (By Number) на ребрах образца, как показано на рисунке 

5.17а. На длину надрезов приходится по 1 элементу. На длину начальной 

трещины приходится также 1 элемент. От вершины начальной трещины до края 

длинного надреза 11 элементов. Здесь мы задали одностороннее сгущение сетки 

(Bias Single) и величину сгущения равную 5 (Bias Ratio). Конечная элементная 

сетка для всей сборки показана на рисунке 5.17 б,в. Недеформируемое тело 

приспособления на элементы не разбивается. 

 
а 

  
б в 

Рисунок 5.17 − Конечно-элементная модель, а − образца, б, в – сборки 

1.8 Запуск на расчет 

Перейдите в модуль  JOB. С помощью иконки  Create Job (либо команд 

меню  Job => Create или дважды кликнув по элементу в дереве модели) создаём 
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задание на расчёт. В появившемся  окне Create Job, присваиваем заданию имя 

Drawing. 

Для продолжения нажимаем кнопку Continue. Задание на расчёт 

сформировано. Чтоб запустить расчёт, вызываем  Job Manager (либо 

раскрываем элемент дерева модели, кликаем правой кнопкой по заданию 

Drawing и выбираем Submit, либо командами меню Job => Manager). 

В появившемся окне Job Manager нажимаем Submit. Надпись Running 

говорит о том, что расчёт запустился. 

1.9 Анализ полученных результатов 

Поля распределений главных максимальных напряжений и перемещений по 

их величине (magnitude) представлены на рисунке 5.18 и 5.19 соответственно. 

Инициирование роста трещины происходит на рисунке 5.18а – произошел рост 

трещины всего на 1 элемент. Дальнейший рост трещины представлен на рисунке 

5.18б-г. Для каждого рисунка указана соответствующая величина приложенного 

момента. Эти моменты соответствуют приращениям 13, 21, 30, 54 в течение шага. 

Когда момент равен максимальному значению 5.5 Н∙м (рис. 5.18г), трещина почти 

полностью проходит сквозь образец. Надо отметить, что максимальное 

напряжение достигается с внутренней стороны образца, где он соприкасается с 

приспособлениями, поэтому максимальное значение не видно на рисунках. 

На рисунке 5.20 представлено инициирование (а) и развитие трещины (б-г) 

по параметру STATUSXFEM, красным цветом указана исходная трещина (в 

эксперименте это усталостная трещина). Статус элемента со значением 1.0 

означает, что элемент полностью треснул. На рисунке 5.20г представлена 

трещина при максимальной нагрузке, приложенной к образцу. 
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а: Момент 2.56 Н м б: Момент 4.06 Н м 

  

в: Момент 4.975 Н м г: Момент 5.5 Н м 

Рисунок 5.18 − Поля распределения главных напряжений [Па] 
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а б 

  
в г 

Рисунок 5.19 − Поля распределения перемещений в модели 
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а б 

  

в г 

Рисунок 5.20 – Статус трещины 

Проведено моделирование зарождения и роста трещины в 3D образце 

Zr-1%Nb в программном комплексе ABAQUS 6-13-2 Student Edition x64 при 

помощи расширенного метода конечного элемента XFEM. 

При выбранной схеме моделирования инициирование трещины происходит 

при главном максимальном напряжении Smax.principal=207 МПа, при дальнейшем 

росте трещины инициирование происходит все с большим значением напряжения 

Smax.principal.  

Показана возможность, наглядность и перспективность использования 

программы ABAQUS при рассмотрении процесса ЗГР. 
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6. Анализ напряжённо-деформированного состояния  
заклёпочных соединений 

Автор: Зигинов Н. В. 

Организация: Гомельский ГТУ им. П.О. Сухого 

E-mail: ziginovnikolay@gmail.com 

В рамках данной задачи производится линейный статический анализ 

заклепочного соединения. На рисунке 6.1 представлена схема задачи. Пластина, 

показанная синим цветом, соединяется с помощью заклепок к жесткой опоре и к 

пластине прикладывается сила F. 

 
Рисунок 6.1 – Постановка задачи 

Исходные данные задачи: сила F=78.1 Н, угол α=39.8о, геометрические 

размеры деталей. Материал пластины и заклепок: Сталь 03. Механические 

характеристики стали указаны в таблице 6.1. 

Таблица 6.1 – Механические характеристики материала Сталь 03 

Наименование параметра Обозначение Величина 

Модуль Юнга, GПа E 200 

Коэффициент Пуассона µ 0,3 
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1.1 Система координат модели и система единиц измерения 

Построение расчетной модели и обработка результатов производится в 

декартовой системе координат. Силу, действующую под углом, раскладываем на 

вектора, действующие вертикально (60 Н) и горизонтально (50 Н). С целью 

уменьшения сингулярности напряжения, каждую из этих сил мы заменяем на 

нагрузку, распределенную вдоль отрезков длиной 0.06 м и 0.05 м для 

вертикальной и горизонтальной составляющих силы соответственно.  

При моделировании принята следующая система измерений - SI. 

Таблица 6.2 – Система единиц измерения  

Длина Сила Масса Время Давление Плотность 

𝑚 𝑁 𝑘𝑔 s Па kg\m3 

1.2 Геометрическая модель 

Открываем в дереве модели модуль PART. Для создания детали нажимаем 

кнопку Create Part   или дважды нажимаем на значке  в дереве 

модели (рис. 6.2). 

 
Рисунок 6.2 – Создание геометрической модели 
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В появившемся окне Create Part (рис. 6.3), задаем имя детали Plate и 

принимаем следующие установки: 2D (двухмерная задача), Deformable 

(деформируемое тело) и Shell (оболочка), в качестве базового свойства. В 

текстовом поле Approximate size (приблизительный размер) набираем 1 м. 

Нажимаем Continue, чтобы закрыть диалоговое окно. 

 
 

Рисунок 6.3 – Построение эскиза модели «Пластина» 

В появившемся рабочем поле чертим контур рассматриваемой пластины 

(рис. 6.3). Для создания прямоугольника по заданным координатам можно 

воспользоваться инструментами  или . Если выбрать инструмент , то 

нужно задать координаты двух противоположных углов прямоугольника, 

например, (0,0) и (0.24, 0.1). Чтобы закончить ввод, нажимаем 2 раза колесико 

мышки или из контекстного меню, вызываемого нажатием правой кнопки мышки, 

выбираем Cancel Procedure. После этого создаем три круглых отверстия для 

заклепок с радиусом 0.01 м. Для этого воспользуемся инструментом задания 

окружности по двум точкам . Нажав кнопку , задаем координаты центра 

первой окружности (0.05,0.05) и координаты какой-либо точки, лежащей на 

окружности, например, (0.06,0.05). Аналогично чертим две другие окружности. У 

них центры располагаются в точках: (0.08,0.05) и (0.11,0.05) (рис. 6.3). 

Заканчиваем построение окружностей, например, выбирая Cancel Procedure из 

контекстного меню. Далее отмечаем две точки, которые ограничивают области 
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приложения вертикальной и горизонтальной нагрузок, – 0.06 м по горизонтали и 

0.05 м по вертикали, от правого нижнего угла. Используя инструмент построения 

точки, задаем координаты (0.18, 0) для одной точки и (0.24, 0.05) – для другой. 

Заканчиваем построение точек. Выходим из режима Эскиз,  нажав кнопку Done.   

Для построения более регулярной конечно-элементной сетки можно 

предварительно разбить модель на ячейки. Для этого нужно провести 

дополнительные горизонтальные и вертикальные линии-отрезки, как показано на 

рисунке 6.4. Это нельзя было сделать ранее, при создании детали в режиме Эскиз, 

однако после создания детали это возможно в режиме разделения геометрии 

Partition. Используем кнопку Partition Face: Sketch и далее выбираем те части 

пластины, которые нужно разделить на ячейки. В данном случае, выбираем всю 

пластину целиком простым щелчком мышки на ней или охватив пластину рамкой 

с помощью мышки. Пластина будет подсвечена. Нажимаем Done. Мы окажемся 

опять в режиме черчения Эскиз, как и при создании пластины. Но сейчас, 

возможно, сетка рабочего поля не будет привязана к углам пластины, и, левый 

нижний угол, который имел координаты (0,0), возможно, будет иметь другие 

координаты. Меняем центр координат с помощью кнопки Sketcher Options. В 

открывшемся окне диалога выбираем General=>Origin и далее в чертежном окне 

выбираем левый нижний угол пластины в качестве центра координат. Нажимаем 

OK. (Заметим, что всегда можно использовать иконку Auto-Fit View, чтобы 

поместить всю деталь в пределах рабочего окна.) Используя инструмент , 

задаем начальные и конечные координаты точек для каждого отрезка, например, 

(0.035,0) − (0.035,0.1) для одного из вертикальных отрезков. Чтобы закончить 

построение линии, выбираем из контекстного меню Cancel Procedure. Далее 

чертим все остальные разделительные линии (рис. 6.4). Выходим из режима 

разделения геометрии, нажав кнопку Done.  

 



 

Современные технологии - в промышленность 

Программное обеспечение 
Инженерный консалтинг 

Вычислительная техника 
Измерительное оборудование 

 
 

103 
 

 
Рисунок 6.4 – Готовый эскиз модели «Пластина» 

Далее создаем геометрическую модель «Заклепка». Для создания детали 

нажимаем кнопку Create Part. В открывшемся окне задаем имя детали Rivet и 

принимаем аналогичные настройки, как и для детали Plate. Для черчения детали в 

режиме Эскиз воспользуемся инструментом . Радиус заклепки 0.01. Задаем 

центр окружности (0,0) и какую-либо точку на окружности, например, (0.01, 0). 

Далее аналогично строим внутреннюю окружность, ее радиус равен 0.004 (рис. 

6.5).  Выходим из режима Эскиз, нажав кнопку Done.   

 
Рисунок 6.5 – Готовый эскиз модели «Заклепка» 
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Для построения более регулярной сетки желательно разбить окружность на 4 

ячейки, как показано на рисунке 6.5 справа. Для этого входим в режим разделения 

геометрии Partition, нажав кнопку Partition Face: Sketch. Выбираем деталь 

заклепки щелчком мышки и нажимаем Done. Мы опять в режиме черчения Эскиз. 

Если центр окружности сейчас имеет координаты отличные от (0, 0), мы меняем 

центр координат рабочего поля и привязываем его к центру окружности. Для 

этого используем Sketcher Options=>General=>Origin и указываем на центр 

окружности в качестве начала координат. Нажимаем OK. Используя инструмент 

, чертим две линии сквозь деталь: горизонтальную с координатами точек 

(−0.01, 0) и (0.01, 0) и вертикальную − с координатами (0, −0.01) и (0, 0.01). 

Выходим из режима Эскиз, нажав кнопку Done. На рисунке 6.6 изображены 

геометрические модели «Плата» и «Заклепка» с разбиениями, описанными выше. 

 
 

Рисунок 6.6 – Геометрические модели «Пластина» и «Заклепка» 

1.3 Модель материала 

 При анализе деталей на напряженно-деформированное состояние достаточно 

задания таких параметров, как модуль Юнга (модуль упругости) и коэффициент 

Пуассона. 

Создаем материал с необходимыми свойствами. В Дереве модели дважды 

нажимаем по контейнеру Materials, чтобы создать новый материал. В 

появившемся окне Edit Material задаем имя Material. В меню редактора выбираем 
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Mechanical=>Elasticity=>Elastic и вводим значение модуля Юнга E= 200E9 Па и 

коэффициента Пуассона µ=0.3 (рис. 6.7). 

 
Рисунок 6.7 – Определение свойств материала 

Далее определяем свойства сечения. Открываем диалоговое окно Create 

Section (вызов возможен либо из Дерева модели, нажав на контейнер Sections, 

либо через иконку ). В диалоговом окне Create Section задаем сечению имя 

Plate. Выбираем в соответствующих списках Solid, Homogeneous и нажимаем 

Continue. В появившемся окне редактора сечений Edit Section, в качестве 

материала указываем созданный ранее материал Material. Аналогично создаем 

сечение с именем Rivet. 

Следующим шагом присваиваем построенные сечения ранее созданным 

деталям. Дважды кликаем по детали пластины в дереве модели. Далее используем 

иконку  Assign Section в модуле Property (либо используем команды меню: 

Assign => Section). С помощью мышки охватываем рамкой всю область пластины, 
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она будет подсвечена красным цветом. Нажимаем Done. В появившемся окне 

(рис. 6.8) выбираем созданное сечение Plate и подтверждаем выбор нажатием 

кнопки ОК. Аналогично присваиваем сечение Rivet детали Rivet (рис. 6.9). 

  
Рисунок 6.8 – Присвоение сечения 

геометрической модели «Пластина» 
Рисунок 6.9 – Присвоение сечения 
геометрической модели «Заклепка» 

1.4 Сборка 

Переходим к модулю ASSEMBLY (сборка). Для создания сборочной 

единицы нажимаем на иконку Create Instance  (также можно в дереве модели 

дважды нажать на элемент из контейнера Assembly, либо 

воспользоваться командами меню Instance=>Create). Появится окно со списком 

созданных деталей Parts. Выбираем деталь Plate – она будет выделена красным 

цветом. В разделе Instance Type указываем Dependent и нажимаем Apply (рис. 

6.10). 
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Рисунок 6.10 – Создание экземпляра сборки «Плата» 

Далее выбираем деталь Rivet. Ставим галочку Auto-offset from other 

instances (вставить со смещением) и нажимаем Apply. Затем добавляем в 

сборку еще две заклепки (рис. 6.11). После нажимаем OK.  

 
Рисунок 6.11 – Результат выполнения команды Create Instance 

Теперь нужно собрать детали (разместить заклепки в нужных местах), 

используя инструмент  Translate Instance. По запросу программы 

выбираем деталь одной из заклепок и нажимаем Done. Далее задаем вектор 

перемещения: сначала выбираем мышкой центр детали заклепки, а затем ту 

точку, в которую этот центр нужно переместить. Нажимаем OK. Заклепка 

переместится в требуемое место. Далее переносим две оставшиеся заклепки. 

Результат сборки представлен на рисунке 6.12. 
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Рисунок 6.12 – Результат сборки 

1.4 Определение процедуры анализа 

В Дереве Модели дважды нажимаем по контейнеру Step. В окне Create Step 

по умолчанию уже присутствует шаг Initial (начальный) – его нельзя изменить. 

Создадим новый шаг анализа, в котором, собственно, и будет производиться 

расчет. Вверху окна вписываем имя нового шага анализа – Step. Выбираем тип 

анализа Linear perturbation из выпадающего меню Procedure Type и далее 

выбираем линейный статический анализ Static, Linear perturbation. Нажимаем 

Continue (рис. 6.13). В появившемся окне Edit Step (редактирование шага), 

оставляем все настройки решателя без изменений и нажимаем ОK. 
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Рисунок 6.13 – Определение процедуры анализа 

1.5 Контактные взаимодействия 

Теперь необходимо создать поверхности для использования в контактных 

взаимодействиях. Для  начала  определим  поверхность контакта для пластины. 

Для более удобного выбора определяемых поверхностей делаем невидимыми 

некоторые из деталей сборки при помощи опции главного меню  View =>Assembly 

Display Options. В появившемся диалоговом  окне Assembly Display Options 

нажимаем по закладке Instance (рис. 6.14). Экземпляры детали, которые вы  

создали,  перечислены  в  списке  с отметками  в  столбце  Visible (видимые). По 

умолчанию видимы все экземпляры деталей. Снимаем флажок в столбце Visible 

рядом с деталями Rivet-1, Rivet-2 и Rivet-3 и нажимаем Apply. Abaqus/CAE 

покажет в графическом окне только пластину. 
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Рисунок 6.14 – Деталь «Пластина» с невидимыми заклепками 

В  Дереве  модели раскроем контейнер Assembly и дважды нажимаем по  

элементу  Surfaces. Появится диалоговое окно Create Surface (рис. 6.15).  В этом 

диалоговом окне задаем поверхности имя SurfPlate-1 и нажимаем Continue. 

Придерживая нажатой клавишу Shift, в графическом окне выбираем мышкой 

последовательно 4 грани по периметру одного из отверстий, которые составляют 

поверхность контакта. Они будут подсвечены красным цветом. Нажимаем 

средней кнопкой мыши (колесиком), чтобы закончить выбор или нажимаем 

кнопку Done. Аналогично определяем поверхности для двух других  отверстий. 

 

 
Рисунок 6.15  –  Создание  поверхностей контакта для пластины 

Теперь определим поверхности контакта для заклепок. Для начала 
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спрячем деталь «Пластина» и сделаем видимыми детали заклепок при помощи 

опции главного меню View=>Assembly Display Options. Мы увидим только 

детали заклепок. В Дереве модели дважды нажимаем по элементу Surfaces под 

контейнером Assembly. Появится диалоговое окно Create Surface. В этом 

диалоговом окне задаем имя SurfRivet-1 и нажимаем Continue (рис. 6.16). В 

графическом окне выбираем последовательно 4 грани на внешней поверхности 

одной из заклепок, которые составляют поверхность контакта. Они будут 

подсвечены красным цветом (рис. 6.16). Нажимаем средней кнопкой мыши, 

чтобы закончить выбор. Аналогично определяем поверхности контакта для 

двух других заклепок. 

 
 

Рисунок 6.16  –  Создание  поверхностей контакта для заклепок 
 

 

После определения поверхностей определяем контактные пары: 

 Поверхность SurfPlate-1 на пластине контактирует с поверхностью 

SurfRivet-1 на заклепке; 

 Поверхность SurfPlate-2 на пластине контактирует с поверхностью 

SurfRivet-2 на заклепке; 

 Поверхность SurfPlate-3 на пластине контактирует с поверхностью 

SurfRivet-3 на заклепке. 

Каждое из трех взаимодействий требует задания свойств контакта. В них 

собрана информация, которая полезна вам для определения конкретных  типов  

взаимодействий. Для создания свойств контакта в Дереве модели  дважды 

нажимаем по контейнеру Interaction Properties, чтобы создать контактное 

свойство. Появится диалоговое окно Create Interaction Property.  Задаем имя 
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свойству IntProp-1. В списке Type применяем выбор по умолчанию Contact и 

нажимаем Continue (рис. 6.17). 

Появится диалоговое окно Edit Contact Property (рис. 6.17).  Из  меню 

диалогового окна выбираем Mechanical=>Tangential Behavior и применяем для 

трения формулировку Frictionless (без трения). Нажимаем OK, чтобы сохранить 

установки и закрыть диалоговое окно Edit Contact Property. 

 

 
Рисунок 6.17  –  Создание свойств контакта 

Далее приступим к созданию контактных взаимодействий. Каждое  

взаимодействие будет ссылаться на свойство, которое мы только что создали. 

В Дереве модели кликаем правой кнопкой мыши по контейнеру  Interaction 

и, в контекстном  меню, выбираем Manager. Появится диалоговое окно 

Interaction Manager. Теперь в левом нижнем углу этого окна нажимаем  Create.  

 Появится диалоговое окно Create Interaction (создание взаимодействия). В 

этом диалоговом окне задаем взаимодействию имя. В списке шагов выбираем 

Initial (начальный шаг), чтобы распространить контактное взаимодействие на все 

шаги, которые следуют за начальным шагом. В списке Types for Selected Step 

применяем выбор по умолчанию Surface-to-surface contact (Standard) 

(поверхность к поверхности) и нажимаем Continue (рис. 6.18). 
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Рисунок 6.18  –  Задание  контактных взаимодействий (а) 

Далее вызываем список уже созданных поверхностей кнопкой Surfaces, 

находящейся в правом нижнем углу рабочего поля. Появится диалоговое окно 

Region Selection, содержащее список поверхностей, которые мы определили 

ранее. 

В диалоговом окне Region Selection выбираем SurfPlate-1 в качестве ведущей 

(master) поверхности и нажимаем Continue (рис. 6.18). Теперь надо определить, 

как будет задаваться поверхность подчиненного типа (slave). В области 

инструкций выбираем кнопку Surface (рис. 6.19). Появится опять диалоговое окно 

Region Selection. 

 

 
Рисунок 6.19  –  Задание  контактных взаимодействий (б) 

В диалоговом окне Region Selection выбираем SurfRivet-1 в качестве 

подчиненной (slave) поверхности и нажимаем Continue (рис. 6.19). 
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Появится диалоговое окно Edit Interaction. В нем для Sliding formulation 

(скольжение) применяем выбор по умолчанию Finite sliding, для Slave Adjustment 

применим выбор по умолчанию No Adjustment.  В качестве свойств выбираем уже 

определенные свойства IntProp-1 из выпадающего меню Contact Interaction 

Property. Нажимаем OK, чтобы сохранить взаимодействие и закрыть диалоговое 

окно (рис. 6.20). 

 
Рисунок 6.20 – Диалоговое окно Edit Interaction 

Контактное взаимодействие двух других заклепок с пластиной создается 

аналогично. 

 1.6 Нагрузки и граничные условия 

 После задания контактных взаимодействий перейдем к граничным условиям 

и нагрузкам,  действующим на  нашу систему.  Для этого в Дереве модели 

нажимаем правой кнопкой мыши по контейнеру BCs и в появившемся  меню 

выбираем Manager. Появится диалоговое окно Boundary Condition Manager. 

Нажимаем Create. Появится диалоговое окно Create Boundary Condition (рис. 

6.21). В нем:  

1) Зададим граничному условию имя BC-1.  
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2) В качестве шага выбираем начальный шаг Initial, чтобы распространить 

наши граничные условия на все шаги, следующие за Initial.  

3) В качестве типа граничного условия выбираем 

Symmetry/Antisymmetry/Encastre (симметрия, антисимметрия, защемление) и 

нажимаем Continue. 

Теперь нужно задать поверхность, к которой будут прикладываться 

граничные условия. Это внутренние поверхности заклепок (отверстия заклепок). 

В графическом окне выбираем последовательно 4 грани, составляющие 

внутреннюю поверхность первой заклепки и нажимаем Done. Появится 

диалоговое окно Edit Boundary Condition. В этом окне выбираем Encastre 

(защемление). Нажимаем OK. Граничные условия для двух других заклепок 

создаются аналогично. 

 
 

 

 
Рисунок 6.21 – Задание граничных условий 

Далее прикладываем силу к пластине в соответствии с условием задачи. 

Для этого в Дереве модели дважды нажимаем по контейнеру Loads, чтобы 

создать новую нагрузку. Появится диалоговое окно Create Load. В нем:  
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1) Задаем нагрузке имя Load-1.  

2) Из выпадающего меню Step выбираем в качестве шага Step, так как на 

начальном шаге Initial механическую нагрузку задать невозможно. 

3) В списке Category применяем выбор по умолчанию Mechanical.  

4) Из списка типов Types for Selected Step выбираем Pressure (давление) и 

нажимаем Continue (рис. 6.22). 

 

 
 

Рисунок 6.22 – Задание области приложения нагрузки на пластину 

В графическом окне с помощью мышки выбираем области, к которым 

прикладывается нагрузка (рис. 6.22). Это вертикальный и горизонтальный 

отрезки в правой части конструкции (см. рис. 6.3). Они будут выделены 

красным цветом.  

Закончим выбор областей, нажав Done. Появится диалоговое окно Edit 

Load. В этом окне выбираем однородную нагрузку Uniform и задаем 

величину распределенной нагрузки 1000 H/м. Нажимаем OK. В графическом 

окне появятся стрелки, показывающие приложенную нагрузку (рис. 6.23).  
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Рисунок 6.23 – Задание нагрузки на пластину 

  

 1.7 Конечно-элементная модель 

Теперь создадим конечно-элементную сетку для каждой из деталей. В дереве 

модели выбираем деталь пластины из контейнера Parts. Выбираем модуль MESH. 

По команде Assign Element Type (Mesh=>Element Type) охватываем рамкой всю 

область детали пластины и нажимаем Done. В окне Element Type будет выбран 

тип элемента CPS4R (рис. 6.24) – это тип элемента по умолчанию, 

соответствующий плосконапряженному состоянию. Нажмите OK. По команде 

Assign Mesh Controls (Mesh=>Mesh Controls) снова охватываем рамкой всю 

область детали пластины и нажимаем Done. В окне Mesh Controls выбираем 

форму элемента Quad (четырехугольник) и способ разбиения Structured 

(структурированный). Нажмите OK. 

 
Рисунок 6.24 – Выбор типа конечных элементов 
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Построим разбиение детали пластины. С помощью команды  задаем  

глобальный шаг конечно-элементной сетки − 0.007 м. Чтобы определить 

локальное разбиение, используем команду . Задаем 3 элемента для 

вертикальных и горизонтальных отрезков, перпендикулярных к отверстиям, и 4 

элемента для каждой четверти отверстия (рис. 6.25). Кроме того, задаем местное 

разбиение для горизонтальных отрезков в правой части детали – здесь мы задаем 

размер одного элемента равным 0.01 м. Создаем сетку для пластины с помощью 

команды  (рис. 6.25).  

Далее переходим к детали заклепки. Здесь выбираем тот же самый тип 

элемента (по умолчанию, это CPS4R) в окне Element Type. В окне Mesh Controls 

выбираем форму элемента Quad и способ разбиения Structured. Нажмите OK. С 

помощью команды  задаем  глобальный шаг сетки − 0.002 м. Далее, используя 

команду , выбираем 4 грани внешней поверхности заклепки и задаем 4 

элемента для каждой из них. Создаем сетку для заклепки с помощью команды  

(рис. 6.25). Изображение сетки для всей сборки можно будет отобразить, выбрав 

из дерева модели контейнер Assembly (сборка) и выбрав модуль MESH. 

Получившаяся сетка для всей сборки изображена на рисунке 6.26. 
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Рисунок 6.25 – Локальное разбиение деталей пластины и заклепки и конечно-

элементная сетка 

 
Рисунок 6.26 – Окончательная конечно-элементная сетка для всей модели 

 1.8 Запуск на расчет 

Перейдем в модуль JOB (рис. 6.27). С помощью иконки Create Job (либо 

команды меню Job=>Create, либо дважды кликнув по контейнеру Job в дереве 

модели) создаем задание на расчет. В появившемся окне Create Job  присваиваем 

заданию имя Analysis. 

  

Рисунок 6.27 – Формирование задания на расчет 
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Для продолжения нажимаем кнопку Continue. Задание на расчет 

сформировано. Для запуска расчета выбираем иконку  Job Manager (рис. 6.28) 

и, в появившемся окне Job Manager, нажимаем на кнопку Submit (запустить). 

Запустить задание на расчет можно также по команде меню Job=>Submit, выбрав 

имя задания Analysis, либо раскрыв контейнер дерева модели и из 

контекстного меню задания Analysis выбрав Submit. 

Надпись Submitted рядом с названием задания Analysis говорит о том, что 

задание запущено. Надпись Submitted затем сменится на Running, что говорит о 

начале процесса расчета. Когда надпись рядом с названием задания в дереве 

модели сменится на Completed, расчет считается завершенным. 

 
Рисунок 6.28 – Вызов Job Manager 

1.9 Анализ полученных результатов 

Чтобы просмотреть результаты, используем команду меню Job=>Results, 

выбрав название задания Analysis. В результате расчетов было установлено, что 

заклепки нагружены неравномерно. Наиболее нагруженной является заклепка 3, 

находящаяся ближе к зоне приложения нагрузки. Наименее нагруженной является 

заклепка 2, расположенная между первой и третьей заклепками. Первая заклепка 

была средненагруженная (нумерация заклепок приведена на рисунке 6.1). 

На рисунке 6.29 показано распределение напряжений по Мизесу. На рисунке 

6.30 показано поле перемещений. 
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Рисунок 6.30 –  Поле перемещений [м] 

 

 

 

 


